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DIgSILENT PowerFactory Introduction to the Tutorial
Chapter A 
Introduction to the Tutorial

This tutorial is intended to introduce the user to the PowerFactory environment. By 
creating and developing his own project, the user goes trough the basic features of the 
software. The project is developed in a step by step manner, where each exercise follows 
on from what has been done in the previous exercise. Users can start each exercise of 
the tutorial by a special PowerFactory command dialog called Tutorial Manager.

Note In order to execute the Tutorial, you need to have a demo version 
or a licensed version of PowerFactory with a license capability of 
at least 30 nodes.

A.1 How to use the Tutorial Manager

By default at the beginning of each exercise the Tutorial Manager provides guides to the 
single line graphics that the user has to implement. At the end of each exercise you can 
get a sample solution by initializing the next exercise with the Tutorial Manager.

The Tutorial Manager is used to install the Tutorial System (the projects used for the exer-
cises) at any of its stages. Although less educational, the Tutorial Manager may be used 
to skip certain parts of the Tutorial without having to enter any data of the preceding exer-
cises.

Note The PowerFactory Tutorial philosophy is to guide the user 
through the features of the software. The data for a small but com-
plete power system design will be entered.

Before starting, new users are recommended to read an introduction to PowerFactory
in order to get an idea of how the program is structured. For convenience, the Power-
Factory introduction presented in the first chapter of this Getting Started Manual is a 
partial reproduction of that given in the User’s Manual.

The instructions to perform each of the tutorial tasks are provided step by step through 
this document. To start with the tutorial itself, go to Chapter C (Exercise 1: Creating the 
Tutorial Project).
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A.1.1 Initialization of the Tutorial Exercises

We use the Tutorial Manager to let it initialize each exercise:

- Open the Tutorial Manager by selecting the File --> Setup Tutorial... option on the 
main menu.

- Select the option Start -> Exercise X. 

- Press the EXECUTE button.

This brings you to the beginning of the each exercise of the Tutorial. For exercise 1 there 
is no initialization, because this exercise begins with the creation of a totally new project. 
If you select to start exercise 1 from within the Tutorial Manager, the Tutorial Manager 
will open chapter C (Exercise 1: Creating the Tutorial Project) of this document only 
without initializing any project in the PowerFactory data base.

Further hints how to use the Tutorial Manager are given in the beginning of chapter D 
(Exercise 2: Creating Power System Elements).

A.1.2 Troubleshooting

As mentioned above the Tutorial Manager installs the data required at the beginning of 
each exercise. This includes a background pattern, which shows where to drop the 
elements in the single line graphic.

Typical questions during working with the Tutorial are:

• The background pattern is not visible in the single line graphic. How to 
make it visible again? 
To make the pattern visible again: 

- Click on the 'Show Layer' icon ( ). The Graphics Layer dialogue appears. The 
'Background' layer is shown in the right pane ('Invisible').

- Move the background layer into the left pane: left click the 'Background' layer and 

press the  button. This moves the background to the list of visible layers.

- Close the layer dialogue.

• I want to continue the tutorial, but it is not active. How to activate it so I 
can continue where I left?

If you interrupted the Tutorial to work on another project, or to close the PowerFactory
program, you may reactivate the Tutorial by selecting it in the File menu. That menu 
keeps a list of the last 5 active projects. The Tutorial should be one of the choices. 

It is also possible to activate the Tutorial project by means of the Data Manager. Press 

the  icon, look for the project in the database tree (left side of the window), right click 
on it and select 'Activate'. It is recommended to make familiar with the Data Manager by 
doing exercise 3, before using it to start the tutorial. A short description about how to 
activate an existing tutorial project within the Data Manager is given in chapter E.2: Using 
the Data Manager.

If you cannot find the tutorial project either in the file menu nor with the Data Manager, 
you will have to start at the beginning on the tutorial exercise where you left the tutorial, 
by selecting Start -> Exercise X in the Tutorial Manager. 
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A.2 Conventions, Terms and Abbreviations used in this 
Manual

Mouse and keyboard handling actions are abbreviated, and a 'shorthand' is also used to 
describe actions that the user should take. To assist the user these shorthand descriptions 
are specifically formatted to stand out, as follows: 

Key As in "Press the left mouse key''. A key is either one of the mouse keys 
or a key on the keyboard. Mouse keys are sometimes called 'buttons', 
as in 'the mouse button.' 

Button As in "Press the OK button''. The word "button'' is used for screen areas 
which perform some action when clicked using the mouse. In other 
words, a 'virtual' button. 

Icons Icons are usually described by the popup name that you read when you 

hover the cursor over it. For example, press  to open the user 
settings dialogue. Icons are also shown as seen on screen, as in the 

press  to open the user settings dialogue. 

Right/Left clicking 
As in "Right click the browser''. Means pointing the cursor at the object 
described (the browser) and pressing the right/left mouse key. 

Double Clicking 
As in "Double click the button''. Means pointing the cursor at the object 
described and pressing the left mouse key twice within about half a 
second (the time interval is as set in the Windows operating system). 

Ctrl-B (key combination example) means that the user should press the 
combination of keys described. For example, "Press Ctrl-B to toggle 
between balanced/unbalanced case,'' means that the user should press 
and hold down the first keyboard key (the Control key on the keyboard 
in this example) and then press the second key (B) as well. 

Menu sequences 
When a user needs to select a command through cascaded menu 
options the sequence is shown by arrows that indicate what option to 
choose next, starting from the original menu button. For example, 
setting the drawing format can be done by pressing the Options 
button to access the options menu, then by choosing "Graphic" from 
the list offered, and finally "Drawing Format..." from the last list; this 
series of actions is all simply described by Options --> Graphic --> 
Drawing Format... 

" " and ' ' 'These' quotes are used to indicate that the description is one that can 
be found within the program- one that is not user definable, for 
example, the balloon help description 'Calculate Load Flow' that you 
see when you hover your cursor over the Load Flow icon. 
"These" are used to indicate data that a user has entered or should 
enter. "These" quotes are also used to indicate a process or series of 
objects that have no discernible name, but which need to be described. 
For example, the "drawing tools panel", which is found on the right 
hand side of the drawing canvas. 
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 and [1] [2] [3], etc. 
These show a sequence of events that should be performed. Where 
they are numbered they will be associated with a graphic in which the 
numbers appear. 

left-clicking, right-clicking, clicking, double-clicking, etc. 
Wherever the instruction clicking or double-clicking appears it should 
be taken to mean clicking and double-clicking using the left mouse 
button. When the right mouse button is to be used it will be explicitly 
stated.
A - 4
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Chapter B 
Program Overview

The calculation program PowerFactory, as written by DIgSILENT, is a computer aided 
engineering tool for the analysis of industrial, utility, and commercial electrical power 
systems. It has been designed as an advanced integrated and interactive software 
package dedicated to electrical power system and control analysis in order to achieve the 
main objectives of planning and operation optimization.

The name DIgSILENT stands for "DIgital SImuLation and Electrical NeTwork calcula-
tion program''. DIgSILENT Version 7 was the world's first power system analysis 
software with an integrated graphical single-line diagram interface. That interactive 
single-line diagram included drawing functions, editing capabilities and all relevant static 
and dynamic calculation features.

The PowerFactory package was designed and developed by qualified engineers and 
programmers with many years of experience in both electrical power system analysis and 
programming fields. The accuracy and validity of the results obtained with this package 
has been confirmed in a large number of implementations, by organizations involved in 
planning and operation of power systems (please see the reference list).

In order to meet today's power system analysis requirements, the DIgSILENT power 
system calculation package was designed as an integrated engineering tool which 
provides a complete 'walk-around' technique through all available functions, rather than 
a collection of different software modules. The following key-features are provided within 
one single executable program:

1 PowerFactory core functions: definition, modification and organization of cases; 
core numerical routines; output and documentation functions 

2 Integrated interactive single line graphic and data case handling 

3 Power system element and base case database 

4 Integrated calculation functions (e.g. line and machine parameter calculation based 
on geometrical or nameplate information) 

5 Power system network configuration with interactive or on-line access to the SCADA 
system 

6 Generic interface for computer-based mapping systems 

By using just a single database, containing all the required data for all equipment within 
a power system (e.g. line data, generator data, protection data, harmonic data, controller 
data), PowerFactory can easily execute any or all available functions, all within the 
same program environment. Some of these functions are load-flow, short-circuit calcula-
tion, harmonic analysis, protection coordination, stability calculation and modal analysis.
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B.1 Database Management and Backups

The PowerFactory database has been proven to be very stable. Nevertheless, as is true 
for all electronic databases, it can be corrupted by external or internal causes. External 
causes are such as power failures resulting in a sudden system shutdown, hard disk 
crashes, computer viruses or inadvertent deletion of files. To prevent any loss of data, 
please follow these instructions: 

• Backup the database directory of all DIgSILENT PowerFactory installations on a 
regular basis. A daily automatic backup is recommended. This directory is named "DB" 
and can normally (i.e. for a standard installation) be found under 
C:\DIgSILENT\pfXXXbYYY where XXX is the version number (e.g. 14.0) and YYY is the 
build number (e.g. 415) i.e. pf140b415 

• Save all projects on a regular basis by right-clicking the project folder in the database 
tree and selecting the Export Data option. This will prompt you for a filename. 
Note: By exporting a project, only the information in that project and all its subfolders 
will be stored. If the exported objects use information (e.g. power system types like 
line or transformer types) that is saved somewhere else, then this information will not 
be stored. Please ensure that the power system types and all other referenced 
information is exported as well. We recommended limiting the use of "non-project 
objects'' to one or two non-project libraries; these should also be exported on a 
regular basis. 

• Exported projects may be imported into a database tree by pressing the  icon on 
the Data Manager's toolbar. You will be prompted for the exported filename (*.dz). 

• Please make sure that you make backup copies of all the exported data, as well as of 
the PowerFactory database on a regular basis. 

• However, should you find yourself in the unhappy position of having a corrupted 
database and no backup files please contact us for assistance; all may not be lost! 

B.2 Designed for Beginners and Experts

DIgSILENT PowerFactory has originally been designed as a complete package for the 
high-end user. Consequently, there are no special 'lightweight' versions, no cut-outs of a 
'heavy' version. This does not, however, mean that non high end users will find them-
selves at sea when using PowerFactory. The program is also friendly to the basic user. 
Users who are learning about power systems are able to easily and quickly perform load-
flows and short-circuit calculations, without needing to immediately master the mathe-
matical intricacies of the calculations. PowerFactory allows the user to learn primarily 
about power systems and not PC quirks- all that is required is a reasonable working 
knowledge of Windows applications such as Word and Excel.

The program is shipped with all of the engines and algorithms that are required for high-
end use. The functionality that has been bought by a user is configured in a matrix, where 
the licensed calculation functions, together with the maximum number of busses, are 
listed as coordinates. In addition, there are options available which will allow the config-
uration and fine-tuning of the software according to the user's needs, for some of the 
functions.

In this manner, not every PowerFactory license contains all functionality described in 
this manual, but only those actually required, thereby reducing the complexity of the 
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outset. As requirements dictate further functionality can be added to the license. The user 
thus does not have to learn a whole new interface for new functions, but merely uses new 
commands within the same environment. In addition, the original network data is used 
and only extra data, as may be required by the new calculation function, needs to be 
added.
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Chapter C  
Exercise 1: Creating the Tutorial Project

The first step in designing a new power system (including that of the Tutorial) is to create 
a project. A project offers the basic structure in which to define and store power system 
definitions, together with their design stages and single line diagrams, type libraries, cal-
culation stages, calculation commands, etc.

This chapter describes how to create a new project and explains most of its features. For 
new users it is recommended to read the PowerFactory introduction (chapter B: 
Program Overview) before starting with the tutorial. It will provide the user with the 
PowerFactory terminology and concepts required to easily understand the rest of this 
document. 

The Tutorial Manager is a special Power Factory feature designed to guide the user 
through this tutorial. It will install a required project for each exercise. For the first 
exercise you cannot use the Tutorial Manager, because the first project should be created 
by yourself.

C.1 Logon to PowerFactory

When starting PowerFactory you have to enter a user name and a password into the 
'Log on' dialogue window. For executing the tutorial you might logon as "Demo" user, 
what is a predefined user account without password. Alternatively you might logon with 
a user-specific name. You are allowed to enter user-specific names in a Demo-version of 
PowerFactory as well, i. e. you are not restricted to use the "Demo" user, if you use a 
Demo-version of PowerFactory. 

If you have a license for a multi-user database, it is recommended, that every user logs 
on with his/her own user name, which is given to him/her by the administrator in this case 
normally.

You can create a new User account easily by typing a new User name in the Log on 
dialogue window of PowerFactory, e. g. 'Tutorial User' or 'MyUser'. This is recommended, 
if you have a Demo-version or if you have a single-user license. While a user name is 
required, the usage of a password is optional (once you have set a password you will have 
to enter it at each logon of course).
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Fig. C.1: Logon to PowerFactory as "Demo" user (left figure) or with a user-specific 
name (here: Tutorial User) and password (right figure)

The location where the Tutorial Manager stores the tutorial projects is called the User
folder (the User folder has the user name entered into the Logon dialogue window). The 
User folder will be the folder created for you by the administrator, or by yourself as written 
above. The active User folder is marked by a small blue screen icon inside the Data 
Manager (the Data Manager will be explained in Exercise 3: The Data Manager). See 
figure C.2 for an example with the user named "Tutorial User". 

 

Fig. C.2: Example of an active user folder

C.2 Creating the Tutorial Project

Create a new project in your User folder by:

Open the File menu on the main menu bar.

Select the New option. 

Choose Project... as shown in figure C.3
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DIgSILENT PowerFactory Tutorial Exercise 1: Creating the Tutorial Project
Fig. C.3: Creating a new Project from the file menu

The dialogue shown in figure C.4 will pop up. This dialogue, as most others in this 
Tutorial, is shown as it should look after we have finished editing it.

 

Fig. C.4: The project dialogue (IntPrj)

Enter the name of the project as "Tutorial Exercise 1''. 

Click the OK button.

This creation of a new project causes any currently active project to be deactivated (if one 
was active) and all related graphic windows to be closed.

A project needs at least one grid folder in which a power (sub)system is defined. There-
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fore, a grid folder is created automatically and its edit dialogue pops up, as depicted in 
the figure C.5.

 

Fig. C.5: The grid edit dialogue

Set the name of the grid to "Part 1''. Again, this name is obligatory, but capitals and 
spaces are not. 

Set the frequency to 50Hz. The PowerFactory tutorial system is designed for 50Hz. 

Left-click the OK button. 

The Owner field is optional and is normally used to enter a project, company or any other 
appropriate name. In this tutorial, the Owner name is not used, although "DIgSILENT 
Tutorial" is entered in figure C.5.

In the background, the new grid "Part 1'' is created in the project, together with a 'Study 
Case' folder which is used to activate the grid and to perform calculations for it. This study 
case is given a default name (which is, surprisingly, "Study Case'').

The newly created project and the study case are activated automatically, an empty single 
line graphic will be displayed. The PowerFactory workspace should now look like shown 
in figure C.6. Here, the following parts of the workspace are visible:

1 The main menu bar as the first row of the window.

2 The main icon bar right below. It contains a list box showing all study cases 
available. Choosing a different study case in that list switches to that study case for 
the model analysis. If there is not enough space to display all buttons on the pane, 
this toolbar is displayed with small 'up' and 'down' arrow buttons, with which the 
rest of the buttons will become available.

3 The local graphics window icon bar - right below the main icon bar - with its buttons. 
This toolbar is also displayed with small 'up' and 'down' arrow buttons which bring 
the additional buttons, if the window is to small to display all buttons. The icons of 
this icon bar depend on the content of the window shown. In this case it is the 
graphics window with the single line diagram.

4 The empty single line graphics window with drawing grid, with grid shown where 
the graphical elements will snap if this option is activated.

5 The drawing toolbox which is displayed in its 'docked' state on the right side of the 
graphics window.
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6 The output window, which is the white window below the graphics window. It is 
used to show text messages, text reports and also shows active links for debugging 
the data model.

7 The status bar (below the message output window) to give feedback about the 
present status of PowerFactory. For example, it indicates the position of the 
cursor either in the graphics window or in the output window is displayed in the 
message bar. It also shows the name of the currently active project.

 
Fig. C.6: The workspace after creation of a new project

C.3 Renaming the Study Case

Although the created project may be used as it is, the name of the new study case is 
normally changed to somewhat more original than "Study Case''.

Select the Edit -> Study Case... option on the main menu.

The edit dialogue of the study case is depicted in the figure C.7.
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Fig. C.7: The study case edit dialogue

Change the name to "Case 1''.

To set the Study Time click in the button with the three dots ( ). A window "Set 
Date and Time of Calculation Case" appears, as shown in figure C.8.

Fig. C.8: Setting Date and Time of the Study Case
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Press the button "-> Date" and the button "-> Time" to set the current computer date 
and time for the study case.

Click the OK button. The study case dialogue window should look like figure now.

Press OK, to save the settings for the study case.

Fig. C.9: The study case dialogue window after changing the settings

The name in the study case list on the main menu should now have changed to "Case 1'' 
too. The study case list shows the currently active study case and may be used to select 
another study case or to deactivate the study case by selecting the empty line.

C.4 Closing and Restarting the  
DIgSILENT PowerFactory Program

The PowerFactory program does not have a "Save'' button for projects. All changes 
made to the system database are immediately stored in the database on disk. This means 
that you may end the program at any time without having to save your work first. There 
just is an option to save Operation Scenarios manually. The concept of Operation 
Scenarios is described in the User's Manual, they are not part of the Tutorial yet.

The software will not reactivate the last active project at start-up. However, the last few 
active projects are kept in the main File menu. Reactivating a recently active project is a 
matter of left clicking one of these entries.

This Tutorial may thus be interrupted at any moment without further actions, and may be 
continued at any time later by only reactivating the Tutorial project. 
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Chapter D 
Exercise 2: Creating Power System Elements

In the previous chapter, a Grid folder ("Part 1'') and a Study Case have been created. This 
would normally be enough to start working. Some additional folders and settings, 
however, which have been created for the Tutorial will make things a bit easier. To install 
these extras, a special command dialogue called Tutorial Manager is provided (see 
chapter A.1). The Tutorial Manager principally does the following: 

• It installs a project containing the predefined tutorial Power System and an equipment 
type library for busbars, lines, transformers and other objects. 

• It prepares the graphic window and sets a background pattern which makes it easier 
to position the elements of the tutorial Power System grids. 

To be able to perform all the tasks proposed for this tutorial, the Tutorial Manager must 
be activated by the user at the start of each tutorial exercise. It will install the predefined 
project. Therefore your first step in creating the tutorial Power System will consist in acti-
vating the Tutorial Manager.

Note The Tutorial Manager will not destroy all user defined experiments 
or alterations made in the tutorial project. Instead of replacing the 
user defined tutorial project, it installs the corresponding pre-
defined tutorial project in parallel. If the tutorial project for the ex-
ercise is already existing, the Tutorial Manager adds a number in 
parentheses to the name of the newly installed project.

Activate the Tutorial Manager: 

Open the File menu on the main menu list.

Select the option Setup Tutorial... 

The Tutorial Manager dialogue appears now.

For this Tutorial exercise, 

Select the option Start -> Exercise 2. 

Press EXECUTE. 
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Fig. D.1: The Tutorial Manager for Starting with Exercise 2

D.1 Creating the Power System Components

The PowerFactory program allows the creation of new power system (parts of new 
power systems) designs by creating all components in a textual database environment 
(called 'Data Manager') and by manually connecting them to define the topology. The 
more convenient method however, is to use the interactive single line graphics.

The single line graphics are used to create new power system components and to insert 
them into the topological network. In this way, the power system database and its single 
line graphic are build together in one action.

Editing the created power system components, for example to set the voltage level or 
other electrical parameters, may also be done from the single line graphic, by double 
clicking the graphical symbols. This will open the corresponding data dialogue of the 
power system component. The following sections shows all this in more detail.

The Tutorial Manager has installed some additional features and has reopened the single 
line graphic. A single line diagram, in grey, is now visible in the background. This is just 
a pattern to show where to place the actual power system components.

D.1.1 Creating Substations with Single Busbars

There are a lot of predefined busbar system arrangements in PowerFactory, for example 
single busbar sytems, single busbar systems with a tie breaker, double busbar systems, 
double busbar systems with a tie breaker and bypass busbar, and so on. All these systems 
consist of terminals, breakers and disconnectors. 
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Note In PowerFactory Version 14 nodes are represented by terminals 
always (what is a difference to previous versions). Terminals may 
be part of a substation, e. g. in a single or double busbar systems. 
A new substation is created for each new 'busbar system' by de-
fault. If you use just simple terminals instead of 'busbar systems' 
to represent nodes, no substation element will be created.  
By clicking with the right mouse button on a terminal and selecting  
'Show detailed Graphic of Substation' a new single line diagram 
with the detailed topology of the substation will be opened. You 
can edit this graphic, if you want to change the topolgy of the sub-
station. You even can add new terminals to a substation. 
When other power system elements, such as lines, transformers or 
loads (known generically as edge and branch elements) are con-
nected to a node, PowerFactory uses breakers to affect this con-
nection. Cubicles with these breakers may be visualized as the 
panels in a switchgear board, or bays in a high voltage yard. Using 
simple terminals, all necessary breakers will be created automati-
cally when an element is connected to the terminal. If you use pre-
defined busbar systems (from templates), you have to select the 
node of one existing breaker to connect the element. This is ex-
plained in detail later in this Tutorial.

To create a substation with a single busbar, a 'Single Busbar System' is used:

If the drawing toolbox is not visible on the right side, click on the  icon in order to 
un-freeze the graphic.

The  icon ('Freeze Mode') changes between graphical editing and parameter editing. 
When pressed, the drawing toolbox will disappear and the single line diagram will be 
'frozen' and can not be changed anymore. You can enter data of the drawn elements in 
both modes, but in the frozen mode (parameter editing) unintentional changings of the 
graphic are not possible. Pressing the 'Freeze Mode' button again will return the drawing 
toolbox ('Un-freeze').

Use the balloon help to find the 'Single Busbar System' icon ( ). The cursor will 
show the single busbar icon after the icon has been pressed. 

Use the background pattern to position the first busbar by left clicking on the drawing 
surface. A busbar will be drawn (in black), and is given a default name like 
"SingleBus / B0.0". Hereby "SingleBus" is the name of the substation, while "B0.0" is 
the name of the terminal (busbar).

If something else than a single busbar appears, press the 'Undo' button ( ) to undo 
your last action(s) and try again. 

Note When the insert mode is activated and the symbol for e.g. the ter-
minal is attached to the mouse arrow, you can switch to the edit 
mode by selecting the  in the drawing toolbox, by pressing the 
ESC key or simply by pressing the right mouse button once.
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The terminal (busbar) of the substation may be moved and resized to fit the background 
pattern:

Select the terminal by left clicking it. This will mark the terminal by a thick grey line 
with two small squares. If something is selected in a frozen diagram, then a hatched 
crossed marking appears, without squares. If you have double clicked the terminal 
accidentally, its edit dialogue will pop up. Close that dialogue with the CANCEL 
button.

Move the terminal by left clicking on the solid grey line and dragging the terminal. 
Releasing the mouse sets the new location.

Resizing is done by left clicking one of the small black squares and dragging it to the 
left or right, see the figure D.2.

The cursor can also be used to show a balloon help text when held still at the name of 
the busbar or at any other text in the single line diagram. This is much more convenient 
than having to zoom in and out in order to read something.

 
Fig. D.2: Resizing a terminal (busbar)

Create two other substations in the same way: 

Select the  icon ('Single Busbar System') in the graphic toolbox again. Place the 
second and third substation (i. e. the terminal of the substation).

Move and/or resize the second and third terminal to fit the background pattern. 

The drawing may be too small to accurately position the terminals. To zoom in on the 
three terminals: 

Left click the 'Zoom In' icon ( ). 

Draw a square around the three busbars by left clicking the first corner, holding the 
mouse key down, and dragging the mouse to the other corner. The selection square 
will be zoomed when the mouse key is released. 

The zoomed in area of the graphic can be moved by using the 'Hand Tool':

Press the 'Hand Tool' icon ( ). The mouse cursor becomes a hand symbol. 

Click inside the drawing pane and keep the mouse button pressed. 

Move the mouse to move the zoomed in area. 

Release the mouse button.

Press the 'Hand Tool' icon ( ) again, to exit the 'Hand Tool' mode.

The 'Hand Tool' mode is available only, if you have zoomed into the graphic. The previous 

zoomed area can be restored by pressing the  icon ('Zoom Back'). The whole area is 

shown when the 'Zoom All' button ( ) is pressed.
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D.1.2 Creating Branch Elements

The terminals (busbars) of the substations are to be connected with transformers: 

Left click the  (two winding transformer) icon in the drawing toolbox. 

To draw the first transformer, left click the upper terminal at the position suggested 
by the background pattern. The transformer is now connected graphically to the 
terminal at that position. 

Left click the middle terminal to make the second connection. 

The detailed graphic of the second substation is opened automatically. Connect the 
transformer to one bay by clicking on one of the marked breaker terminals as 
illustrated in figure D.3. The result should look like figure D.4.

Note There is a difference between simple terminals (without substa-
tions) and the predefined more complex busbar systems with sub-
stations, which are representing substations in detail: If you place 
an element to a busbar system, the detailed graphic of the substa-
tion (busbar system) is opened. You have to connect the element 
(here the transformer) to one of the marked terminals (the big 
squares which are at the end of the predefined breaker panels).

Fig. D.3: Connecting the transformer to the single busbar system  
(in detailed substation graphic)
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Fig. D.4: Transformer connected to the single busbar system

Afterwards the detailed graphic of the first substation is opened automatically. 
Connect the transformer to one bay again by clicking on one of the marked breaker 
terminals.

Use the same method to connect a second transformer between the middle and lower 
terminal. 

The single line diagram, without the background, should now look like the figure D.5. 

 
Fig. D.5: Three substations with single busbar systems and two transformers

If something else than a transformer has appeared or if the connection was not made as 

intended, press the 'Undo' button ( ) to delete the created transformer. Pressing ESC
while drawing will cancel the drawing of the transformer.

The transformer may be moved similar to the same way a busbar is resized: 

Left click a transformer to select it. 
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Left click the selected transformer, hold down the mouse key. 

Move the transformer one or two grid points left or right by dragging. 

Release the mouse button. 

Normally, you cannot drag the transformer outside the range of the two terminals. If you 
try this, it will be positioned at the terminals, as far to the right or left as possible. If you 
try again from this position, you can drag it outside the range. 

Move the transformer back to its original position. If the connections were crippled 

during the first move, press 'Undo' button ( ) to undo the move. 

You can also draw the transformer symbol again by right clicking it, and selecting 
Reconnect Graphically from the contextsensitive menu. This will mark the two terminals 
to which the transformer is electrically connected. You can re-draw the transformer again, 
but you have to connect it to the two marked terminals.

The option Reconnect Graphically is available for all symbols in the single line diagram 
and it can be used to restore the diagram.

Left clicking the upper and then the lower terminal while drawing a the transformer 
creates a straight connection. The transformer symbol is placed in the middle. A non-
straight connection would have been made if we would 

First left click a terminal to make the first connection. 

Left click the drawing surface to define corners in the connection line. 

Double click on the drawing surface to place the transformer symbol. 

Left click the drawing surface again to draw the second connection line, 

and left click the second terminal to make the second connection. 

The detailed graphics of the substations will pop up after that, in order to let you 
connect the transformer to the breaker panels.

You may want to practice this now, using the option Reconnect Graphically.

D.1.3 Creating Single Port Elements

Single port elements are power system elements which are connected to one terminal 
only: generators, motor, loads, external grids, etc.

The tutorial grid has two asynchronous machines: 

Press the  icon in the drawing toolbox.

Connect the first machine to the lower terminal by left clicking it on the position as 
shown by the background pattern.

The detailed graphics of the substations pops up. Connect the machine to one breaker 
panel by clicking on one of the marked breaker terminals.

Connect the second machine to the middle terminal.

Left clicking a terminal places the single port symbol with a straight connection. Non-
straight connections may be made by first left clicking the drawing area to place the 
symbol, then to draw a non-straight connection and finally left clicking the terminal to 
make the connection.
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To finish off the tutorial grid, we need to place the external grid: 

Press the  icon in the drawing toolbox. 

Left click the upper terminal to connect the external grid. 

Again the detailed graphics of the substations pops up. Connect the external grid to 
one breaker panel by clicking on one of the marked breaker terminals.

If the external grid is connected to the terminal in the overview diagram at the same 
position as the transformer, the external grid symbol is automatically positioned above 
the terminal. Otherwise, it is placed in the default position under the terminal. 

If the external grid symbol is drawn in the downwards position, it may be flipped upwards. 
If the external grid symbol is already positioned correctly, you may want to practice the 
following on the machine on the middle busbar: 

Right-click the external grid symbol or the asynchronous machine. The context 
sensitive menu appears (see the figure D.6). 

Left click the Flip At Busbar option. The symbol is rotated 180 degrees around its 
busbar connection. 

Flipping is also possible with non-straight connections.

This concludes the creation of the power system elements and the topology. Please check 
that all symbols are positioned correctly. Use 'Move', 'Resize' and/or 'Flip at busbar' to 
correct the single line diagram.

The elements, however, have not been edited yet, and are all using default parameters. 
Entering the parameters is the next step.

We don't need the background pattern anymore. To hide it, we have to disable the 
graphical layer on which it is drawn. For every group of graphic symbols, such a layer 
exists. To hide the background: 

Click on the 'Show Layer' icon ( ). The Graphic Layers dialogue appears. The 
"Background'' layer is shown in the left pane ('Visible'). 

Hide the background by moving it to the right pane: left click the 'Background' layer 

and press the  button. This moves the background to the list of invisible layers. 

Close the layer dialogue with the OK button. The single line graphic will now look 
more sharp. 
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Fig. D.6: Flipping a symbol
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D.2 Editing the Power System Components

The PowerFactory program offers several methods for editing the electrical parameters 
of power system elements, from simple edit dialogues to flexible spreadsheet-like envi-
ronments where more than one element is visible at the same time.

The most simple and direct method, however, is to double click the elements in the single 
line graphic, which opens their edit dialogue.

To avoid unintended changes of the single line diagram, press the 'Freeze Mode' button 

( ) to freeze the diagram.

Almost all of the power system elements are using Type objects. A large group of trans-
formers, for instance, may all be of the same type. Most of the electrical parameters are 
thus defined in a transformer Type object and each transformer will reference that type.

Normally, this would mean that a library of user defined types has to be created prior to 
defining power system elements. However, for this tutorial all needed types have been 
predefined and are ready to use.

D.2.1 Editing Terminals and Substations

To edit the upper substation with its terminal:

Double click the upper terminal. The edit dialogue for the terminal, as depicted in the 
figure D.7 will pop up.

This dialogue shows: 

• Page tabs which are used to enter calculation specific parameters ('Basic data', 'Load 
Flow', etc.).

• The name of the terminal. 

• Its type, with a button to select a type and one to edit the type. 

• A Zone and an Area, to which the terminal belongs. These aren’t used in this turotial. 
Further information about Zones and Areas is available in the User’s Manual.

• The substation to which this terminal belongs, with a button which opens the edit 
dialogue of that substation.

• The System Type (AC, DC, or AC/BI for two phase AC systems like railway systems)

• The Phase Technology to define the number of phases. You can select for example 
whether the terminal has a neutral conductor or not.

• The nominal voltage of the terminal. 
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Fig. D.7: The busbar edit dialogue

Edit the upper terminal and substation: 

Name = "D1_Swab''. 

To enter the Type, left click the type selection button ( ) and choose the Select 
Project Type option. This opens the library in the database tree. Please navigate to 
the 'Types Busbars' folder as shown in figure D.8. This busbar library has been 
installed by the Tutorial Manager. When needed, click on the '+' symbol to open the 
Database subfolders or doubleclick them.

Select the "Bar 33 kV" type by left clicking the small object icon. Holding the mouse 
still above the object icon will bring a balloon help as depicted in figure D.8. 

Press OK to select the busbar type. The terminal edit dialogue will become active 
again. 

Press the button with the blue arrow beneath the 'Substation' entry in order to edit 
the substation.

The dialogue window of the substations appears (figure D.9). Change the name of the 
substation to "Station 1".

Enter "S1" for the 'Short Name'.

Press the button 'Set Nominal Voltage' in order to set the nominal voltage for the 
whole substation.

Enter 33 kV as shown in figure D.10.

Close the substation dialogue by pressing OK.

Note, the nominal voltage of the terminal has changed to 33 kV automatically. The 
nominal voltage of a terminal may be different from that of its type. The selected 
busbar type is designed for 33 kV, but may be used for other (lower) voltage levels. 
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Press OK to close the dialogue window of the terminal.

 
Fig. D.8: Selecting a busbar type

Fig. D.9: Editing the Terminal and Substation
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Fig. D.10: Setting the nominal voltage of a substation

The middle substation with its terminal is edited in the same way:

Double click the middle terminal.

Name = "D1_11a''.

Select the type: use  --> Select Project Type --> Bar 11 kV.

Name of the substation "Station 2", short name = "S2"

Set the nominal voltage of the substation to 11 kV

Close all dialogues by pressing OK.

The lower terminal is at 3.3 kV:

Name = "D1_3.3a''

Type = Project Type --> Bar 3.3 kV

Name of the substation "Station 3", short name = "S3"

Set the nominal voltage of the substation to 3.3 kV

Close all dialogues by pressing OK.
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D.2.2 Jumping to Other Elements

All element edit dialogues are equipped with a JUMP TO.. button. Pressing this button 
either jumps directly to the connected element, if there is only one such an element, or 
shows a list of connected elements from which one may be selected.

To practice this: 

Double click the external net symbol to open its dialogue.

Press the JUMP TO.. button. The dialogue of the terminal "D1_Swab" appears 
now.

Press the JUMP TO... button again. A list of connected elements appears. Select 
the transformer. The edit dialogue of the transformer appears.

Press the CANCEL button in any edit dialogue to exit without changes.

D.2.3 Editing Two-Port Elements

To edit the top transformer:

Double click the transformer to open its dialogue.

Name = "T1_33/11a''

The dialogue shows the connected terminals. These fields have been set when the 
transformer was connected in the single line diagram. The names of the terminals are 
shown in red.

Type = Project Type --> TR2 20;33/11;10. 

Open the 'Load Flow' page by left clicking the page tab.

Check that the automatic tap changer is disabled and that the tap position is set to 
zero.

Press OK.

An error message will be displayed if the HV and LV sides of the transformer are 
connected wrongly. In that case:

Press the FLIP CONNECTIONS button on the 'Basic Data' page. 

Press OK again. 

To edit the other transformer: 

Open its dialogue. 

Name = "T1_11/3.3a''.

Type = Project Type --> TR2 5;11/3.3;5% 

Check on the 'Load Flow' page that the automatic tap changer is disabled and that the 
tap position is set to zero. 
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D.2.4 Editing Single Port Elements

To edit the external grid open the edit dialog and set: 

'Basic Data':

- Name = "Transmission Grid''

- The external grid element has no type. All electrical data is stored in the element 
itself. 

'Load Flow' data: 

- Bus Type = "SL'' (slack)

- Angle = 0.0 deg

- Voltage Setpoint = 1.0 p.u

VDE/IEC Short-Circuit: 

- Max. Short Circuit Power ''Sk'' = 10000 MVA

- R/X ratio = 0.1

Press OK .

To edit the 11 kV induction machine:

Open its dialogue. 

Name = "ASM1a'' 

Type = Project Type --> "ASM 11kV 5MVA''

'Load Flow' page --> Active Power = 4 MW 

Press OK. 

To edit the 3.3 kV induction machine: 

Open its dialogue.

Name = "ASM1b''

Type = Project Type --> "ASM 3.3kV 2MVA''

'Load Flow' page: Active Power = 1 MW 

Press OK.

This concludes the power system definition of the first exercise. We may now start a cal-
culation.
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D.3 Performing a Load Flow

A load flow calculation may be started from the main menu (Calculation - Load flow...), 

or by clicking on the Load Flow icon ( ) on the main toolbar. This will bring the load 
flow command dialogue to the front, as depicted in the figure D.11. 

This command dialogue offers several options for the load flow calculations. 

For this first tutorial load flow, check that the following options are set: 

- Calculation Method = AC Load Flow, balanced, positive sequence. 

- Disable all other options on the basic options page.  
The red command line should now read 'ldf/notopt/disp'. 

Press the EXECUTE button. 

 

Fig. D.11: The load flow command dialogue

A load flow calculation is now started. If the tutorial power system was entered correctly, 
the following message should appear in the output window:

DIgSI/info - Element 'Part 1\Transmission Grid.ElmXnet' is local reference 
in separated area 'Part 1\D1_Swab.ElmTerm'

DIgSI/info - Calculating load flow...
DIgSI/info - -------------------------------------------------------------
DIgSI/info - Start Newton-Raphson Algorithm...
DIgSI/info - load flow iteration: 1
DIgSI/info - load flow iteration: 2
DIgSI/info - Newton-Raphson converged with 2 iterations.
DIgSI/info - Load flow calculation successful.
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If an error was found, an error message like the following could appear:

DIgSI/err  - 'Part 1\T1_33/11a.ElmTr2':
DIgSI/err  - missing type !
DIgSI/err  - Error in load flow data!
DIgSI/info - Load flow calculation not executed.
DIgSI/err  - last command leads to error(s), see output window !

In this case (the transformer has no type set), the load flow calculation is not executed.

To resolve the error, one should first find the element for which the error was reported. 
With the interactive PowerFactory output window, this is easy: just double click the line 
with the element's name in the output window. This will automatically open the element's 
edit dialogue. Correct the error and try the load flow again.

The correct load flow message shows that the load flow command has found one separate 
network in the system and recognized that the only possible power source was the 
external grid element.

The single line graphic shows the results of the loadflow in the result boxes, as is depicted 
in the figure D.12. 

 

Fig. D.12: Results of the load flow calculation

In this figure, the balloon text help which appears if the cursor is held still over a result 
box is shown also. Especially when a larger part of a power system is viewed, the result 
boxes may become hard to read. The balloon help may then be used to view the results.

D.4 Editing the Result Box Format

The result boxes are not fixed to the currently visible result parameters, but may be freely 
edited. PowerFactory offers highly flexible result box definition tools with which about 
any possible result box format may be defined.

In this tutorial, only the most direct way of changing a result box definition is used. For 
some users, this method may be sufficient for their needs. Other users may want to read 
the parts about editing result box definitions in the User's Manual after they finished the 
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tutorial.

To understand the way the format of the result boxes is managed and edited, it's 
important to understand the nature of the PowerFactory result boxes. 

D.4.1 Background Information About Result Boxes

A PowerFactory result box is actually a tiny calculation report. In principle, there is no 
difference between a complex multi page load flow report and the small result box of a 
line. Both reports are generated by so-called result forms, which use the DIgSILENT
output language to define the contents of the report.

Just to get some idea about what this is all about, the following example of a part of a 
result form is given. Normally the user doesn’t have to edit this result form manually, 
because there are easy to use dialogs for editing available, which are presented in 
chapter D.4.2. The following example has been taken from a large load flow report 
format, which included macros, loops and many other reporting commands. The example 
shows a piece from the heading of the report, where totals are reported for the generation 
and motor load active and reactive power. 

Generation   Motor |$HE
             Load  |$HE
   [# ]/     [# ]/ |$HE,[c:Pgen,[c:Pmot
  [#   ]    [#   ] |$HE,[c:Qgen,[c:Qmot

Important here is to understand that we may also write such report forms for the result 
box of a line. Because we want to see other results after we've performed a short circuit 
calculation than after a load flow calculation, we may create two small report forms; one 
for reporting, for instance, the initial short circuit current and apparent power, and one 
for reporting the active power, the reactive power and the power factor.

It is thus clear that it must be possible to create and select a result box format for each 
available calculation function. Besides that, we generally want to see other results for 
branch elements than for node elements. The flexibility of the PowerFactory result box 
formats even extends these basic requirements by offering the definition of results boxes 
for different projects, for a single edge element or for all edge elements at once, for a 
single particular element or for element classes (lines vs. transformers, for instance), etc., 
etc. This flexibility leads to a high amount of result box formats. To manage all these 
formats, without losing track, the following features are offered: 

• The PowerFactory program is shipped with a complete range of default result box 
formats, which are stored in a read-only folder.

• New, user defined formats are stored in an user defined folder, and will be based on 
the default formats.

• A very flexible Form Manager is used to assign result formats to all elements or to all 
edge and node elements, as long as they have not been assigned their own format 
before. It is therefore possible to use special dedicated formats in some cases, 
without losing the ability to change the overall format without much effort.

• The result box format of all edge or node elements may be chosen in the main menu 
from a small, possibly user defined, selection.

In the following section, the result box format of the external network element will be 
changed.
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Note By default in result boxes the power flowing into branch elements 
has positive sign, while that flowing out of them has negative sign. 
For consuming edge elements (loads) the same convention is fol-
lowed. In the case of producing elements (external networks and 
generators) power flowing out of the element nodes is positive 
while that flowing in is negative.

D.4.2 Editing the Result Box Format

The result boxes of the top transformer shows P, Q and loading. For example, we want 
to change this to P, Q and current. To change the result box definition:

Freeze the single line diagram ( ).

Right click a result box of the transformer. This pops up a small menu.

Holding the mouse still at one of the Format for... options (Format for Edge Elements or 
Format for 2-Winding-Transformers) will show a second menu. You can select another 
result box format from this list. The menu shows with a small checkmark ( ) which 
format is being used. Currecntly the 'Format for Edge Elements -> Power Loading' is used.

Selecting the option Edit format for... will open the currently used form definition 
dialogue.

Select the option Edit Format for Edge Elements. The format dialogue window 
appears (see figure D.13).

Press the INPUT MODE button and select Predefined Variables, if this is not 
selected yet. Press OK .

The Line frame shows three drop-down boxes which show the currently selected vari-
ables.

Press the select button  for the third line (which shows 'c:loading') and select the 
variable 'm:I:_LOCALBUS kA Current, Magnitude'.

Press the OK button.
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Fig. D.13: Editing result boxes using predefined variables

Observe the change in the result box for the transformer. It now shows the current. 
Try the balloon help, it has changed too.

Observe that all result boxes for the transformers have changed.

Select the option Edit Format for Edge Elements again. Try setting the number of 
digits to 3 or 4, or adding the unit by using the Unit check box 'Show'.

If the result box becomes too small to display everything:

• Un-freeze the diagram ( ). 

• Right click the result box and select the Adapt width option.

It isn't often necessary to add units or descriptions to the result box formats because 
these are also given in the single line legend, and are shown in the balloon help. The 
legend in the lower left corner of the single line diagram is automatically updated when 
the result box formats are changed.

The legend is shown or hidden by pressing the  icon.
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D.5 Performing Short-Circuit Calculations

A short-circuit calculation may be started from the main menu (Calculation -->Short-

Circuit), by clicking on the short-circuit icon ( ) on the main toolbar, or directly from 
the single line graphic: 

Freeze the diagram. 

Right click the 11 kV busbar "D1_11a'', and select the Calculate --> Short-Circuit 
option as shown in figure D.14. 

This opens the short-circuit command dialogue, as is depicted in the figure D.15

Set the Method = According to IEC

Set the Fault Type = 3-phase Short-Circuit

Enable the Fault Location option User Selection and select the the fault location if 
necessary. This is done automatically, if you have started the short-circuit calculation 
from the single line graphic as descripted.

Press the EXECUTE button.

Fig. D.14: Starting a short-circuit calculation from the single line graphic
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Fig. D.15: The short-circuit command dialogue

A short-circuit calculation is started for a short-circuit at the selected busbar only. The 
results show the currents in the whole network, except for the load element, which is 
neglected.

The output window should show the following message:

DIgSI/info - Element 'Part 1\Transmission Grid.ElmXnet' is local reference 
in separated area 'Part 1\D1_Swab.ElmTerm'

DIgSI/info - Short-circuit calculated at Terminal Part 1\D1_11a
DIgSI/info - Short-circuit calculation ready !

To calculate short circuits for all busbars and terminals at once:

Click on the short-circuit icon ( ) on the main toolbar.

Set the Method = According to IEC

Set the Fault Type = 3-phase Short-Circuit

Enable the Fault Location option 'Busbars/Junction and Internal Nodes'.

Press the EXECUTE button.

A short-circuit analysis is made for all nodes (busbars, terminals). The results are given 
locally for each terminal as the short-circuit currents and power that flows to that terminal 
in case of a short-circuit at that terminal.

To calculate a multiple fault (fault at more than one elements at the same time):

Perform a balanced load flow.
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Multi-select two terminals by using the CRTL -Key.

Right click the selection and select the Calculate --> Multiple Faults... option. 

A browser window with a list of fault locations appear. This list contains the selected 
terminals and additional terminals, if they have been selected before. You can edit 

this list (delete entries or create new one by using the 'New Object' button ( ) of 
the browser window).

Click OK
The short-circuit command appears again. It should have the method set to 
'Complete' and the option 'Multiple Faults' should be enabled.

Press the EXECUTE button.

The short-circuit currents and power in the network are calculated for the simultaneous 
short-circuits.
D - 23



DIgSILENT PowerFactory Tutorial Exercise 2: Creating Power System Elements
D - 24



DIgSILENT PowerFactory Tutorial Exercise 3: The Data Manager
Chapter E 
Exercise 3: The Data Manager

In the second exercise of the tutorial, the main menu, the main icon bar, the drawing 
tollbox, and the single line graphic were used to:

• Create a new project and a new grid.

• Define and edit a new part of a power system.

• Calculate loads flows and short-circuits.

• Look at results.

The Tutorial Manager is used again to install some additional settings for this third 
exercise of the tutorial now: 

Select the File --> Setup Tutorial... option on the main menu. 

Select the Start -> Exercise 3 option in the Tutorial Manager. 

Press Execute. 

The single line diagram should disappear and reappear again with a different background 
pattern.

The database, in which all changes were stored, has not been used directly.

To view and use the database, we need to open the so-called ''Data Manager'':

Press the button 'New Data Manager' ( ) on the main icon bar. A Data Manager 
window, as depicted in the figure E.1, will be opened.

The Data Manager has two windows:

• The database tree window (left pane) which shows a tree representation of the whole 
database

• The database browser window (right pane) which shows the contents of the selected 
folder in the database.
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Fig. E.1: The Data Manager

E.1 The Data Manager: Basics

Users familiar with the "Windows Explorer'' may want to skip this section.

The database tree window shows a hierarchical tree with 'Folder' objects. If such a folder 
contains other objects, it has a small plus sign ( ). This sign may be left clicked to open 
the folder. The database browser in the right side panel will show the contents of the open 
folder.

An open folder will show its status by a small minus sign ( ). Left clicking this sign will 
close the folder. In the figure E.1, the folders "Tutorial User'', "Tutorial'' (project), 
"Library", "Network Model" etc. are open, the folders "Equipment Type Library", "Opera-
tional Library" and so on are closed. The "Part 1'' folder is selected in the tree, and its 
contents are thus shown in the browser on the right.

Left click all minus signs until the database tree only shows the basic Database folder. 

Left click the plus signs until the folder Database \ User \ Tutorial \ Network Model \ 
Network Data \ Part1 is open. The User folder is your working folder; the one with the 
small blue icon (monitor screen). It may have another name than User.

Double clicking a folder may also be used to expand and collapse folders.

Left clicking a folder in the database tree will show its contents in the database browser: 

Left click the folder "Part1''. The browser now shows all objects created in the second 
exercise of the tutorial.
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The objects displayed in the browser may be sorted to the column field by left clicking the 
column heads:

Left click the column head "Name''. The objects are sorted to name.

Left click the same head. The objects are sorted the other way around.

Left click the empty first column head (above the icons, left of the "Name'' column). 
This sorts the objects according to their class.

If the Data Manager window is too small:

Point the mouse at a border or corner of the Data Manager window. The mouse 
cursor will change into a double arrow. The border/corner may now be dragged to 
resize the window.

The whole Data Manager window can be moved by left clicking its title bar and 
dragging the whole window (keeping the mouse button down).

The tree and browser pane are separated by a vertical splitter bar. This bar may be 
dragged to enlarge the tree or browser pane.

E.2 Using the Data Manager

Open the Data Manager and have a look into your User folder (Database \ User). In 
addition to the projects of the previous exercises of the tutorial, the Tutorial Manager has 
installed and activated a new project called "Tutorial Exercise 3". An activated project is 
indicated by bold printed letters inside the Data Manager. We are working with this 
project now. If you want to go back to any preceding exercise, you can activate the cor-
responding project by right clicking on the project folder and selecting Activate from the 
context-sensitive menu.

The Data Manager may be used to edit the power system components:

Select the folder Database \ User \ Tutorial Exercise 3 \ Network Model \ 
Network Data \ Part 1 (select it in the tree).

In the browser, double click the small icon for a transformer ( ). This will open the 
same edit dialogue as was opened from the single line diagram.

Close the edit dialogue with Cancel.

The Data Manager is a very versatile object which may be used for many things, e.g. 

• Create any kind of object ''manually'', i.e. projects, calculation cases, type libraries, 
calculation commands, variations, etc.

• Copy and paste parts of the database from one folder into another.

• Look at results in table format.

• Edit objects in table format.

• Import and export parts of the database.
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E.3 Adding a Branched-Off Line

We are now going to expand the system by adding a distribution cable with loads, to the 
middle terminal.

We start by drawing the extra substation right of the 11 kV terminal:

Un-freeze the single line diagram (only necessary if the freeze mode is active).

Select the  icon in the drawing toolbox and place the new substation with a single 
busbar to the right of "D1_11a''. 

Because this busbar is electrically similar to "D1_11a'', we are going to copy the data: 

Left-click "D1_11a''. 

Press and hold the Ctrl-key and left-click the new terminal. Both terminals should be 
selected now.

Right-click one of the selected terminals and select Edit Data. Alternatively, double 
click the selected busbars. A database browser will open which shows the two 
terminals. 

Select "D1_11a'' by pressing the  icon. 

Copy the busbar (either right click and select Copy, press the  icon or press 
Ctlr-C. 

Right-click the  of the new busbar and select Paste Data.

Open the edit dialogue of the new busbar (by double clicking the  icon) and check 
that it has the "Bar 11kV'' as type and 11 kV as the nominal voltage. 

Close the dialogue and close the database browser (OK buttons). 

This method of copying data from the one to the other object can be used to speed up 
the definition of networks and to reduce mistakes. A large distribution system that uses 
many terminals (or stations, busbars resp.) which are electrically similar, for example, 
could be drawn in the single line diagram. One of these terminals could then be edited to 
have the correct type and voltage level. By selecting all similar terminals, and opening a 
database browser as described above, the terminal data can be copied, and pasted to all 
other terminals in one action.

Copying and pasting data is possible for all objects, including transformers, lines, loads, 
generators, etc.

Of course, the new terminal needs a name of its own: 

Open the dialogue of the new terminal (double click the terminal in the single line 
graphics). 

Name = "D2_Swab" 

Name of the substation = "Station 4", short name = "S4"

To create the cable between the terminals "D1_11a'' and "D2_Swab'': 

Select a 'Line'  from the drawing toolbox. 
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Draw the line according to the background pattern:

- Left click the terminal "D1_11a''

- Left click the drawing area to create the two corners of the line

- Left click the other terminal ("D2_Swab'').

- Connect the line to the breaker panels of the substations.

Double click and then edit the line:

- Name = "L1_Swab'' 

- To select the type click on the black down arrow button ( ): 
--> Select Project Type  
--> Line Type (TypLne)  
--> Types Cables (library subfolder)  
--> Cable 11kV800A (the Line becomes a cable)  
--> Select the cable type and press the OK button of the browser window

- Length = 3 km 

Press OK 

We are now going to add a cable to the right 11 kV busbar: 

Select the 'Short Terminal' element from the drawing toolbox. This kind of terminal 
doesn’t represent a whole substation. This element is rather used for simple grid 
nodes (connection points).

Place the short terminal below the terminal "D2_Swab'', as shown in the background 
at the end of the next line (between line end and load). 

Edit the terminal: 

- Name = "D1_Reut''

- Type = Project Type -->Bar 11kV 

- Nominal Voltage = 11 kV 

Select a 'Line' from the toolbox. 

Draw a straight line between busbar "D2_Swab'' and the new terminal "D1_Reut''.

The detailed graphic of the substation "D2_Swab'' is opened. Connect the line to one 
breaker panel.

Note A difference between a simple terminal and a substation with a de-
tailed busbar system is, that at simple terminals a breaker for the 
connection of a branch element is created automatically, while you 
have to connect the branch element to an existing breaker panel 
of the substation. A simple terminal gets just one simple breaker 
instead of a detailed breaker configuration which consists of break-
ers and disconnectors. You can whatch the detailed graphic of the 
terminal with its connections by right clicking on the terminal und 
selecting 'Show Detailed Graphic of Node'.
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Double click the line in order to edit it.

- Name = "L_Swb_Rt'' 

- Type = Project Type --> Line Type (TypLne) --> Types Cables (library subfolder)  
--> Cable 11kV400A (again a cable) 

- Length = 5 km 

Connect a load ( ) at the Short Terminal at the end of the line.

Your single line graphic (without background guides) should now look like the figure E.2.

 

Fig. E.2: New cable, short terminal and load

To create the branches of the new cable: 

Select the 'Load' element from the toolbox.

Left click ON THE LINE, at the position where the upper load is connected. A 'Branch-
Off Element' dialogue should pop up. If this doesn't happen, but a single load symbol 
is placed on the diagram, the line was missed. Press Esc to try again in that case, 
possibly after the area has been zoomed.

To insert the load into the line, a small terminal is inserted. The 'Branch-Off Element' 
dialogue is used to define the physical position of the terminal and if switches should be 
inserted.
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Set the New Position to 4 km. The 'Branch-Off Element' dialogue shows the valid 
interval (0 to 5 km).

The Switch options (Insert Switches on Right Side / Left Side) should be disabled.

Press OK.

The new load symbol is attached to the line 90 degrees turned.

The physical position of the line-branch has no relation to the graphical distance of the 
branch to the top terminal "D2_Swab'', as seen in the single line diagram. Of course, the 
order of the branches in the diagram equals the physical order, but the graphical 
distances between them have no meaning. 

Insert the lower load in the same way. Set it at 4.8 km, that means enter 0.8 km, 
because the dialogues counts from the inserted terminal above, also without 
switches. 

Insert the third load between the two other ones.

Set the load at 4.4 km (enter 0,4 km).

Enable the left switch option.

Flip the connection of the load:

- Click with the right mouse button into the empty drawing area to free the mouse 
pointer from the load

- click on the last inserted load element with the left louse button and hold the 
mouse button pressed

- move the load to the other side of the line as indicated by the background figure

- free the mouse button to drop the load on the new position

The third load is now inserted 180 degrees turned. It is also possible to  right click it after 
inserting, and to select Flip At Busbar. This will rotate the element 180 degrees around 
its busbar connection.

This concludes the topological changes for the third exercise of the tutorial. Notice that 
the name of the line ("L_Swb_Rt'') has been replaced in the single line graphic, because 
the line was splitted into four lines. They have the automatically created names 
"L_Swb_Rt'', "L_Swb_Rt(1)'', "L_Swb_Rt(2)'', and "L_Swb_Rt(3)'' now. The new elements 
will be edited in the next section of this chapter. 

The grey background pattern is not needed anymore: 

Click on the 'Show Layer...' icon ( ) on the single line graphic icon bar. This opens 
the 'Graphic Layers' edit dialogue. 

The 'Background' layer is in the 'Visible' pane. Left click it to select it and press the 

 button to move it to the 'Invisible' pane. Double clicking the 'Background' layer 
does the same. 

Close the dialogue. 

The background is now invisible. 

Freeze the diagram again. 
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E.4 Editing the New Elements

Because we already set a type and a length for the branched-off line, we just have to edit 
the names of the new created lines:

Double click the upper line:

- Name = "L_Swb_Tub" 

Double click the second line route from above:

- Name = "L_Tub_Dus'' 

Name the third route:

- Name = "L_Dus_Gom'' 

Name the bottom route: 

- Name = "L_Gom_Reut'' 

The insertion of loads into the line has created new line elements, and it also inserted 
terminals between the lines. The loads were connected through those terminals. We have 
to edit these terminals too. It would be a nuisance to edit them one by one, as they all 
are the same. We therefore are going to use the "multi-edit'' capabilities of the database 
browser. 

Open a Data Manager window.

In the database tree window left click the grid folder "Part 1'' (figure E.3).

Fig. E.3: Data Manager window with the new lines and terminals  
(after editing them)

The browser shows now amongst other parameters, the names and types of the 
elements, as in figure E.3. The types of the three new terminals ("Terminal", "Termi-
nal(1)", and "Terminal(2)") are not set yet. This is what we are going to change now:

Double click one of the terminal icons ( ) in the first column of the browser. This 
opens the terminal edit dialogue.
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Set the type to: Project Type --> Bar 11kV.

Close the dialogue with OK.

We now return in the browser, which shows the selected type for the edited terminal. The 
two other terminals should get the same type, which is the reason why we are going to 
copy the type from the first terminal to the other two:

Left click the type field of the edited terminal. This selects the field only.

Right click this type field. This opens the context sensitive menu.

Select the option Copy from the context sensitive menu or use Ctrl+C.

Rigth click the empty type field of one of the other terminals and select the option 
Paste from the context sensitive menu or use Ctrl+V. This copies the type.

Paste the type again for the other terminal.

Please recognize, that the entries in the column 'Object modified' are updated with 
the current date and time automatically.

The browser should now show all elements having their type field set. We will set the 
names of the new terminals now:

Double click in the name field of "Terminal" with the left mouse button.

Change the name to "D1_Tub"

Click with the left mouse button into the name field of "Terminal(1)"

A window pops up and askes, if you want to save the changings to 
"D2_Tub.ElmTerm". Confirm with Yes.

Change the name of "Terminal(1)" to "D1_Gom"

Repeat with "Terminal(2)" and change its name to "D1_Dus"

Close the browser window.

The end-terminal ("D1_Reut") may already have the correct type and nominal voltage set. 
Double click the symbol in the single line graphic and check that its data corresponds to:

- Type = Project Type --> Bar 11 kV

- Nom. voltage = 11 kV

We want to group the new lines with the terminals in one Branch object, to make clear 
that they belong together.

Open the Data Manager again.

Select the grid folder "Part 1" and click with the right mouse button.

Select 'New --> Branch' from the context-sensitive menu as shown in figure E.4.

A new branch object is created.

Name the branch "L_Swb_Reut".

Select the terminals "D1_Tub", "D1_Gom", and "D1_Dus".

Cut them by clicking with the right mouse button on the selection and choosing 'Cut'.

Select the new branch object "L_Swb_Reut" in the left pane of the Data Manager.
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Click with the right mouse button and select 'Paste'. This will paste the terminals into 
the branch object.

Select the lines "L_Swb_Tub", "L_Tub_Dus'', "L_Dus_Gom'', and "L_Gom_Reut''.

Cut and paste them into the branch object as well.

Figure E.5 shows how the filled branch object folder looks like in the Data Manager. 

Fig. E.4: Creating a new Branch in the Data Manager

Fig. E.5: The filled Branch object in the Data Manager

Finally we have to edit the Branch object itself:

Right click the Branch object in the Data Manager.

Select Edit from the context sensitive menu. The dialogue window of the Branch 
(ElmBranch) appears.
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Press the 'Update' button in order to select the connections and the limiting 
component of the Branch automatically (figure E.6). This will update the Resulting 
Values of the Branch (length, rated current, impedances etc.), too.

Close the dialogue by clicking the OK button.

Fig. E.6: Updated Branch object

The copy and paste method is now used to set the types of the four new loads. In that 
way, the chance of leaving one load out or making a mistake is reduced.

Multi select the four new loads (select the first, keep the Ctrl down and select the 
others).

Right click the selection and choose Edit Data. A browser with the four loads pops up. 
None of them should have its type field set yet.

Open the dialogue of the first load (double click the icon), set its type to Project Type 
(Select Porject Type) --> General Load Type (TypLod) --> Types Loads (library 
subfolder) --> General Load and close the selection dialogue with OK.

Close the dialogue of the load with OK as well.

Copy and paste the type to the other loads.

Close the browser. 

Copying and pasting data from one element to another is just one of the many data 
editing features of the database browser. Every parameter may be copied and pasted, 
and most of them may be edited directly without having to open the edit dialogue, as if 
we were using a spreadsheet. However, we will now continue to use the single line 
graphics. 
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The new loads are now separately edited to set their power demand. 

Edit the top load. 

- 'Basic Data' tab:
Name = "Tubin''

- 'Load Flow' tab:
Balanced/Unbalanced = Balanced 
Active Power = 4.0 MW 
Power Factor = 0.9 
Voltage = 1.0 p.u. 

Note When the Active Power and/or the Power Factor are not visible, 
you can select 'P, cos(phi)' as 'Input Mode' for the current load. 
It is also possible to edit the default input mode for all loads by 
pressing the   button and then selecting 'Active Power' and  
'cos(phi)' . All loads are assumed to be inductive (standard). 

Edit the middle load: 

- 'Basic Data':
Name = "Duslin'' 

- 'Load Flow':
Balanced/Unbalanced = Balanced 
Active Power = 1.0 MW
Power Factor = 0.9
Voltage = 1.0 p.u.

Bottom load:

- 'Basic Data': 
Name = "Goma'' 

- 'Load Flow':
Balanced/Unbalanced = Balanced 
Active Power = 1 MW 
Power Factor = 0.9 
Voltage = 1.0 p.u. 

Load at the end terminal: 

- 'Basic Data': 
Name = "Reutlin'' 

- 'Load Flow': 
Balanced/Unbalanced = Balanced 
Active Power = 3 MW 
Power Factor = 0.9 
Voltage = 1.0 p.u. 

This concludes the design of the power system so far.
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E.5 Performing Calculations

Perform a load flow calculation: 

- Balanced, positive sequence. 

- All other options disabled. 

We want to know from the results, if any of the elements is overloaded. To get visible 
information about the loading of the elements we will colour the graphic.

Fig. E.7: Colour Representation of Graphic

Click the 'Colour Representation' button ( ) in the graphic window icon bar.  
The 'Colour Representation of Graphic' dialogue will open (figure E.7).

Select Colouring: 'Low and High Voltage / Loading'

Change the 'Loading Range' for 'Max. Loading of Edge Element' to:

-   90 %

-   95 %

- 100 %
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The dialogue window should look like figure E.7 now. Close the dialogue with OK.

We can see, that the upper transformer and cable "L_Swb_Tub" are overloaded (marked 
red). The voltage in the whole grid is relatively low (blue terminals). If your network 
graphic is not coloured although you edited the 'Colour Representation', run a load flow 
calculation again. This will make the colouring appear.

For improving this situation we have to do some changes with the equipment. As an 
example we will take a bigger cable for cable "L_Swb_Tub":

Double click the cable "L_Swb_Tub"

Select a new cable type:

- Press the  button.

- Select Project Type --> Line Type (TypLne)

- Cable 11kV800A 

- Confirm this selection by clicking OK.

- Close the line dialogue with OK.

Run a new load flow. You will see, that the cable isn't overloaded now.

Because we inserted a switch in the line just before the middle load, we may switch off 
the last three loads: 

Enlarge an area around the middle load (zoom in with ).

Right click the serial switch in the route.

Select Open. The switch symbol will turn white.

Alternatively, double click the switch symbol with the left mouse button to open it or 
to close it.

Zoom out and perform a load flow. Observe the differences.

With the line open, a short-circuit on the end-terminal makes no sense:

Right click the end-terminal "D1_Reut".

Select Calculate - Short-Circuit. 

Perform a short-circuit calculation according to:

Method = According to IEC 

Fault = 3-phase Short Circuit

This will lead to an error, because there is no generator unit found in the separated 
network. You will get warning and error messages.

Close the switch again in the same way as it was opened. 

Perform the short-circuit calculation again. It will now execute normally. 

This concludes the third exercise of the tutorial.
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Chapter F 
Exercise 4: Creation of a Second Subsystem

In this fourth exercise, we will create the second part of the tutorial power system, which 
is a high voltage transmission system.

For this fourth tutorial exercise, we need a new Grid folder: 

If the Tutorial project is not active: 

- In the main menu select the File and then the Tutorial project from the list of 
recently active projects. 

- If you can not find an entry for the tutorial, refer to the 'Trouble Shooting' list given 
in chapter A.1.2.

Make sure that the study case "Case 1'' is activated. It should be visible in the study 
case list from the main menu. If no study case is shown, select "Case 1''. 

Select the Edit --> Project option on the main menu. This opens the project edit 
dialogue. 

Press the New Grid button. This opens the ElmNet dialogue. 

Enter the name of the new grid as "Part 2'' and press OK. An ' Open Grid' query will 
ask what to do with the new grid. 

Select the option add this Grid/System Stage to active Study Case?

Press OK. 

An empty single line graphic with the name "Part 2'' will open. 

As was done in the previous exercises, we have to execute the Tutorial Manager to do 
some preparations for the fourth exercise: 

Set up the Tutorial Manager by selecting the File --> Setup Tutorial... option on the 
main menu. 

Select the Start -> Exercise 4.

Press Execute. 

Again, a new empty single line graphic will pop up. This graphic shows the background 
pattern of the small transmission system from "Part 2''. You are now ready to enter that 
transmission system.
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F.1 Creating the Topology

The single line diagram shows a pattern with four double busbars and some loads and 
generators attached to them. You are going to create these elements.

Zoom in on the background pattern and create the double busbar systems: 

Un-freeze the single line diagram (necessary only if the freeze mode is active). 

Select the 'Double Busbar System' (DBS) from the drawing toolbox ( ).

Place the upper DBS. 

Select both busbars of the DBS by drawing a rectangle over them: left click the 
drawing sheet, drag the mouse to draw the rectangle, release the mouse to select 
both busbars. The DBS does not have to fit in the square: every element that is partly 
in the square will be selected. In the figure F.1, two busbars are about to be selected 
by dragging a small square over them. Be sure to also select the bus coupler before 
moving. 

Move the DBS if it does not coincide with the background pattern. 

Enlarge the DBS by dragging one of the right side black squares, until it fits the 
background pattern. Because both busbars are selected, both are enlarged by 
dragging the black square. If you select one of the tweo busbars only, you can 
enlarge them indivudually.

 
Fig. F.1: Selecting two busbars

Place the left, middle and right double busbar systems as shown in the background 
pattern and enlarge and/or move them to cover the background pattern. 

Create the loads at the four busbars, according to the background pattern:

- Select the load from the drawing toolbox.

- Place it on the according busbar systems

- The detailed graphic of the substation (busbar system) is opened. Connect the load 
to one of the marked terminals (the big squares which are at the end of the 
breaker configurations).

The load at the upper DBS has to be placed above the DBS: press the Ctrl key when 
placing it or use the Flip at Busbar option. 

Create three synchronous machines at the upper, left and right DBS. The machine at 
the upper DBS has to be placed upside down again. 

Before we connect the lines with the busbars, we have to add new cubicles (breakers) to 
the double busbar systems. The predefined busbar systems, which are taken from tem-
plates, have a specific number of breakers. New breakers are not created automatically, 
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if you connect elements with the busbars. Advanced users can create their own tem-
plates, which might have more breakers than the predefined ones (if you want to do this, 
refer to the User's Manual, please). To add breakers to the existing double bus bar 
systems:

Go to on of the detailed graphics of the substations as shown in figure F.2. If the 
graphic pages are not available, click on the double busbar system in the graphic 
"Part 2" with the right mouse button and select 'Show Detailed Graphic of Substation' 
from the context sensitive menu.

Select the two terminals (busbars) and enlarge them.

Mark one of the empty breaker bays (cubicles).

Click with the right mouse button on the breaker selection and select 'Copy' from the 
context sensitive menu (alternatively press Ctrl-C).

Click with the right mouse button into the empty drawing area and select 'Paste' from 
the context sensitive menu (alternatively press Ctrl-V).

Connect the newly created breakers with the busbar system.

Repeat the last two steps to create and connect another breaker system with the 
busbar system. The detailed graphic should look similar to figure F.3 now.

Repeat all with the other double busbar substations in the grid.

Fig. F.2: Detailed Graphic of a substation with double busbar system
F - 3



DIgSILENT PowerFactory Tutorial Exercise 4: Creation of a Second Subsystem
Fig. F.3: Double busbar system with two new cubicles

Now we can connect the lines to the busbars: 

Create the 6 lines according to the background pattern in the graphic "Part 2":

- Select the line from the drawing toolbar.

- Click on one of the double busbar systems in the graphic "Part 2".

- Drag the line to a second double busbar systems in the graphic "Part 2" and click 
on that double busbar systems.

- The detailed graphic of the second substation is opened automatically.

- Connect the line to one bay by clicking on one marked breaker terminal.

- The detailed graphic of the first substation is opened automatically.

- Connect the line to one bay by clicking on one marked breaker terminal.

- Repeat these steps to draw and connect all lines.

After that the topology is complete and the background pattern is not needed anymore: 

Hide the background pattern (using the  icon). 

Freeze the diagram again. 

F.2 Editing the Elements

At first we should name the four stations, which contain the double busbar systems:

Double click on one terminal of the upper double busbar system in the graphic 
"Part 2". The dialogue window of the terminal will open.

Press the 'Edit' button (the button with the little blue arrow) beneath the substation 
entry. The dialogue window of the substation will open.

Rename the upper substation to "Station 1" as shown in figure F.4.

Repeat with the other double busbar systems:
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Rename the lower left substation to "Station 2".

Rename the lower middle substation to "Station 3".

Rename the lower right substation to "Station 4".

Fig. F.4: Renaming substations

Give each terminal its name. 

Double click each terminal (busbar) to edit: 

- Top Busbars: Name = "B110_1a'' and "B110_1b'' 

- Left Busbars: Name = "B110_2a'' and "B110_2b'' 

- Middle Busbars: Name = "B110_3a'' and "B110_3b'' 

- Right Busbars: Name = "B110_4a'' and "B110_4b'' 

All the busbars of the system (there are 8) are equal, they all are designed for 
110 kV.Thus it is a good idea to edit them by copying data: 

Click on the icon 'Edit relevant objects for calculation'  on the graphics window icon 

bar ( ). This will show a list with icons for all object classes found in the active 
project. 

Press the 'Terminal (*.ElmTerm)'  icon ( ). 

A database browser appears with all terminals in the project. 
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Double click the first terminal icon ( ) from one terminal with the name "B110_..." 
and edit the terminal to have:

- Type = Project Type --> Bar 110 kV 

- Nom. Voltage = 110 kV 

Close the terminal dialogue. The browser now shows the type and nominal voltage. 

First left click, then right click the entered type field in the browser and select Copy. 

Left click the empty type field of the second terminal with the name "B110_...". Drag 
the mouse to the empty type field of the last terminal with the name "B110_...". 
Release the mouse key. All the empty type fields should now be selected. 

Right click the selected fields and select Paste. The busbar type is now copied to all 
other busbars at once. 

Check the nominal voltages of the terminals with the names "B110_...". If necessary 
repeat the copy and paste for the nominal Voltage. 

Close the browser. 

The copy and paste method is now used to enter the type for the six lines. 

Click on the  icon again and select the line symbol ( ). 

Edit the line with the name "Line" in the browser: 

- Type = Project Type --> Line Type (TypLne) --> Types Lines --> OHL 110 kV 

Copy the type to the other five lines with the names "Line(1)" til "Line(5)". 

Close the browser.

Although all the lines share the same line type, they have different lengths. To enter the 
line lengths: 

Edit the four vertical lines from the upper DBS to the left and right DBS, by double 
clicking them: 

- Length = 60 km 

Edit the remaining two lines to the center DBS: 

- Length = 20 km 

Name the lines: 

The two lines on the left side between "Station 1 / B110_1x'' and "Station 2 / 
B110_2x'':

- Name = "L12a'' and "L12b'' 

The lines between "Station 1 / B110_1x'' and "Station 4 / B110_4x'':

- Name = "L14a'' and "L14b'' 

The line between "Station 2 / B110_2x'' and "Station 3 / B110_3x'':

- Name = "L23'' 

The line between "Station 4 / B110_4x'' and "Station 3 / B110_3x'':

- Name = "L43'' 
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Edit the six loads: 

Click the  icon and select the load symbol ( ). A browser window with all loads 
will open. From the second column of the table you can see, which load belongs to 
the grid ''Part 1'' and which belongs to ''Part 2''.

In the 'Basic Data'  tab, set the type for the first load, which belongs to ''Part 2'':

- Type = Project Type --> Equipment Type Library --> Types Loads --> General 
Load 

Paste the Type to the other five loads which belong to ''Part 2''. 

In the 'Load Flow' tab set the input mode and the power demand parameters for the 
first load:

- Input Mode= PC (this means P, cos(phi))

- Active Power = 100 MW 

- Power Factor = 0.95 

Paste the Input Mode, the Active Power and Power Factor to the other five loads. 

Close the browser. 

Note When editing with the data browser, the  Detailed Mode ( icon 
in the browser toolbar) is activated. It allows the editing of the ob-
ject’s calculation data sets by clicking in the corresponding page 
tabs (as in the object dialogs). If the Detailed Mode is deactivated, 
by pressing the button, the Object Mode is enabled and only a lim-
ited set of data is accessible for editing. Further information is giv-
en in the User’s Manual.

Name the loads at the top, left and right busbar systems. Double click to edit each of 
them. 

Top load: Name = "Ld_1'' 

Left load: Name = "Ld_2'' 

Right load: Name = "Ld_4'' 

The loads at the middle busbar system have a different power demand. Double click to 
edit each of them. 

Edit the left load: 

- Name = "Ld_3a'' 

- Active Power = 40 MW 

- Power Factor = 0.95 

Edit the right load: 

- Name = "Ld_3b'' 

- Active Power = 40 MW 

- Power Factor = 0.95 
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Edit the center load: 

- Name = "Ld_Swab'' 

- Active Power = 20 MW 

- Power Factor = 0.90 

Finally, edit the generators one by one: 

Top generator: 

- 'Basic Data':
Name = "SM_1'' 
Type = Project Type --> Types Mach. Sym. --> SGEN150M/110kV 

- 'Load Flow': 
Reference Machine = enabled 
Mode of Local Voltage Controller = Voltage 
Voltage = 1.0 p.u. for the Dispatch 
Angle = 0.0 deg.

Left generator:

- 'Basic Data': 
Name = "SM_2'' 
Type = Project Type --> Types Mach. Sym. --> SGEN150M/110kV

- 'Load Flow': 
Reference Machine = disabled 
Mode of Local Voltage Controller = Power Factor 
Active Power = 100.0 MW 
Power Factor = 0.95 

Right generator: 

- 'Basic Data': 
Name = "SM_4'' 
Type = Project Type --> Types Mach. Sym. --> SGEN150M/110kV 

- 'Load Flow': 
Reference Machine = disabled 
Mode of Local Voltage Controller = Power Factor 
Active Power = 100.0 MW 
Power Factor = 0.95 

Note If the Active Power and/or the Power Factor fields are not visible 
in the 'Load Flow' page, select P,cos(phi) in the Dispatch --> Input 
Mode option. 
F - 8



DIgSILENT PowerFactory Tutorial Exercise 4: Creation of a Second Subsystem
F.3 Performing Calculations

Perform a load flow with the option Consider Reactive Power Limits enabled (see 
figure F.5). 

Correct the system in case of errors. 

Fig. F.5: Consider Reactive Power Limits in the Load Flow Calculation

The secondary controller function for the power system (frequency control => equilibrium 
between power demand and power production) is performed by the top generator alone. 
The other two generators are fixed to a certain PQ setpoint (active and reactive power). 
Due to this control settings, the upper generator is heavily overloaded. However, we 
cannot simply set all generators to the "SL'' (slack) mode, because this would create three 
reference busbars which would all have a voltage angle of 0.0 degrees.

The solution is to select one reference busbar, for which the voltage angle will be 
0.0 degrees, and to create a frequency controller object which will regulate the power 
output of the generators. 

Edit all three generators: 

- Reference Machine = disabled 

- Local Voltage Controller = Voltage 

- Active Power = 100.0 MW 

- Voltage = 1.0 p.u. 

This gives all generators a "PV'' characteristic. 
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Define the power frequency controller:

- Select the upper terminal "B110_1a" of "Station 1" and the three generators (by 
clicking on them whole holding the Ctrl key pressed). 

- Right click the selection and choose the Define --> Power-Frequency Controller 
option. The edit dialogue of a power frequency controller will appear. 

Fig. F.6: Defining a Power-Frequency Controller

The power-frequency controller already has the "Bus Bar of Frequency Measurement'' 
field set. The selected generators are in the machine list. 

- Enable the option According to Nom. Power. 
- In the 'Basic Data' page, set the name of the controller: 

 Name = ''Secondary Control''

- Close the controller dialogue with OK. 

The new element ''Secondary Control'' has been created in the database. 

It is also possible to add generators to an existing frequency controller. This is done from 
the single line diagram: 

- Multi select the generators, right click the selection. 

- Select the Add to --> Power-Frequency Controller. A list of existing frequency 
controllers is shown from which the one must be selected to which we want to add 
the generators. 

- The frequency controller dialogue appears. The generators are now added to the 
machines list when they were not already in it. 

- Close the frequency controller dialogue. 

The load flow will be different now: 

Open the load flow command. 

At the 'Active Power Control' page, enable According to secondary control. 
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Perform a load flow. Observe the changes: all generators are now producing equal 
real power. The power contribution is not fixed but can be changed in the frequency 
controller by setting it to Individual active power and editing the percentages in the 
list. 

The frequency controller can be reached by opening the dialogue of a participating gen-
erator. The controller object is mentioned on the 'Load Flow' page as External Secondary 
Controller. The button beside it can be clicked to jump to the controller.

This concludes the fourth exercise of the tutorial.
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Chapter G 
Exercise 5: Connecting the Subsystems

In the previous exercises of the tutorial, a small distribution system ("Part 1'') and a small 
transmission system ("Part 2'') have been entered and tested; in addition, load flow and 
short circuit-calculations were performed for both systems. 

In this exercise of the tutorial, these two networks are going to be connected to each 
other and calculations for the resulting network will be performed.

To again install some additional objects, start the Tutorial Manager by doing the follow-
ing: 

Open the Tutorial Manager by selecting the File --> Setup Tutorial option on the main 
menu. 

Select the option Start -> Exercise 5. 

Press Execute. 

If there was a project active before, the graphics board disappears, but nothing else 
happens visibly! The grids are not shown automatically this time.

G.1 Activation of the Two Subsystems

For the connection and analysis of the two subsystems, it should be possible to switch 
from one single line graphic to the other quickly and to perform calculations for the com-
bination of the two grids. Until now, only one subsystem ("Part 1'' or "Part 2'') was active 
at the same time. However, you may activate as many grids, and add as many single line 
diagrams to the graphics board as needed. For now, you need to activate and show 
(single line diagrams) the created "Part 1'' and "Part 2''grids.

A grid folder is activated by adding it to an active study case. The study case keeps a 
reference to all the active grids, therefore the combination of the defined active grids will 
be the target for all the performed calculations. The study case will automatically deacti-
vate all its grids when it is deactivated itself, and will reactivate them again when it is 
activated, using the grid references. You thus first have to activate the study case by 
selecting it in the study case list in the main menu. 
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Fig. G.1: Database tree

The following describes how grids can be added to a study case from a data manager 
window: 

Open a data manager window by pressing the  button. 

Expand the Tutorial project in the tree. The Tutorial project should now look like 
depicted in the figure G.1. Both the Tutorial project and the study case should be 
active (red coloured icons). 

Add the two grids to the study case by right clicking them and selecting Add to Study 
Case. Their icons will also become red to signal their active status. 

Close the data manager window. 

The graphics board that will appear shows both single line diagrams. You can switch 
between them by pressing the tabs on the bottom of the graphics board.

When a study case is deactivated, it will automatically close its graphics board. When it 
is activated again, the graphics board will be shown again too.

We thus have two active grids, and two single line graphics. The background pattern of 
the transmission system shows some alterations that are to be made. First, check to see 
that both grids have been activated: 

Perform a load flow calculation ( ) with the following settings in the basic option 
tab: 

- AC Load Flow, balanced, positive sequence Calculation Method. 

- Consider reactive power limits. 
- All other options disabled. 

The load flow command now sees one single network, which has two isolated areas. In 
the output window several messages are printed out; one of these messages should read 
: 
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DIgSI/info - Grid splitted into 2 isolated areas.

Switch to the other single line diagram and observe that the load flow was calculated for 
both grids. You may have to enlarge (zoom) the diagram a bit to see the results in the 
result boxes, or point at a result box to get a balloon help.

You are now ready to connect the two grids.

G.2 Connecting Two Grids

The distribution grid ("Part 1'') is fed by an external grid element, at 33 kV. The transmis-
sion grid has a load element in the middle which represents the distribution grid, as 
depicted in the figure G.2 by the red arrow. 

Fig. G.2: Transmission grid single line diagram (Part 2). Middle load representing the 
distribution load

In order to connect the two grids, we would need: 

• To dispose of the external net object in the distribution grid, and the middle load 
element in the transmission grid. 

• To create a 110/33 kV transformer and connect the 110 kV double busbar system in 
"Part 2'' with the 33 kV busbar in "Part 1''. 

The first step is easy, because it concerns either the one or the other grid: 

Select and un-freeze the "Part 1'' diagram. 
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Left click the external net symbol and press the delete ( ) button. Answer Yes to 
delete the object. 

Select and un-freeze the "Part 2'' diagram. 

Delete the load "Ld_Swab'' on the middle busbar system in the same way. 

The creation of the new transformer, however, is not possible. We cannot create it 
because we need two busbars in a single line graphic in order to connect a new trans-
former between them. The "Part 1'' single line diagram doesn't have the 110 kV busbar 
system, and the "Part 2'' doesn't have the 33 kV busbar. At least one of these busbars 
must be made visible in the other diagram.

We therefore have to create a second graphical representation of one of these busbars: 

Open the single line diagram "Part 1'', select the busbar "D1_Swab'' and copy it 

(either press the  button, right click the selection and choose copy, or press Ctrl-
C).

Change to the single line diagram "Part 2''. 

Right click at the indicated position below the mid DBS in the diagram and select 
Paste Graphic Only.

A new graphical symbol of the "D1_Swab'' busbar is now created in the other single line 
diagram. However, no new busbar is created in the database. Electrically, there is still only 
one "D1_Swab'' busbar.

Some additional aspects of the graphical copy and paste:

• The same method for graphical copy and paste is available for all objects.

• Copy and Paste 'graphically' is also possible for more than one object at the same 
time. The symbols are pasted in the same configuration as when they where copied. 
Care must be taken to prevent symbols to be drawn outside the drawing plane. A 
change to a larger paper size will bring these objects back into focus.

• Only one graphical symbol of each object is allowed in each single line diagram. It is 
not possible to graphically copy and paste inside the same diagram.

To check upon the new busbar symbol:

Open its dialogue. Its name should be

...\Station 1\D1_Swab.ElmTerm

If the inserted busbar is called other than "D1_Swab'', you created a new busbar, in stead 
of creating a new symbol for the existing "D1_Swab'' busbar. In that case:

Press the 'Undo' button ( ) to dispose of the created busbar.

Try again.

We have now created a second graphical representation of the busbar "D1_Swab'' in the 
single line diagram "Part 2''.

We may now connect the busbars by means of a transformer: 

Select the 2 winding transformer from the toolbox and draw a new transformer 
between double busbar system and the copied busbar 

Edit the transformer: 
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- Name = "T1_Swab'' 

- Type = Project Type -->TR2 60;110/33 

This concludes the topological changes for this exercise of the tutorial. 

Hide the background pattern. 

Freeze both diagrams. 

The transformer now connects the two sub systems: 

Perform a load flow calculation. 

The transmission system is now supplying the distribution network with about 14.51 MW. 
The whole system is regarded as a whole by all calculation modules: 

Perform a short-circuit calculation for a 3 phase short circuit at the end terminal of the 
branched-off line in the distribution system. The short-circuit is now fed by the three 
generators in the transmission network. 

This concludes the fifth exercise of the tutorial.

G.2.1 More About Multiple Graphical Representations

The method for pasting single power system elements from a single line diagram into 
another single line diagram is just one of the methods of creating single line representa-
tions of existing power system elements.

This method may be used as described for connecting two power system grids, but it is 
not so suited for creating completely new single line diagrams for existing grids. The 
PowerFactory software offers special tools for that.

If you are interested in creating single line diagrams from existing net data, you may want 
to read the User's Manual, chapter Graphics Windows, section Building From Predefined 
Objects (7.1.5).
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Chapter H 
Exercise 6: Motor Start Simulation

Until now, only two calculation functions have been used in this tutorial: the load flow and 
the short circuit calculation. 

In this tutorial exercise, one of the generators in the transmission network is going to be 
replaced by a more detailed model of a power plant. This power plant model will contain 
one large asynchronous motor for which a motor startup calculation will be performed. 

To again install some additional objects, start the Tutorial Manager by doing the follow-
ing: 

Open the Tutorial Manager by selecting the File --> Setup Tutorial option on the main 
menu. 

Select the option Start -> Exercise 6. 

Press Execute. 

The graphics board should now show the two single line graphics from the last exercise 
of the Tutorial and two new tabs called Motor and Voltage. 

Perform a load flow by pressing the  button in order to check the power system. 

H.1 Modelling the Power Plant

The top generator ("SM_1'') in the transmission system (''Part 2'') is to be replaced by a 
more detailed model of a power plant. The desired plant model should be already visible 
in the background pattern. In order to delete the generator do the following: 

Left click the generator and press the delete button ( ). 

Answer the question by Yes. 

The deleted generator, however, participated in the secondary control, therefore this has 
to be corrected: 

Open a browser containing the secondary controls by pressing   button on the 
main toolbar and then . The browser window should only contain one secondary 
control in this example.

Open the secondary control dialogue by double clicking on it and go to the 'Load Flow' 
tab. 
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The power-frequency control element is still using the deleted generator "SM_1'', 
which is shown in red. Right click the row with this generator (right click the number 
in the first column) and select Delete Rows. This clears the generator from the power-
frequency control element. 

Press the Ok button and close the browser window. 

To enter the model of the power plant: 

Use the background pattern to draw a new single busbar above the double busbar 

system by selecting the single busbar system icon  from the graphical toolbox. 

Connect the busbar to the double busbar system by two lines by selecting the line 

icon   from the graphical toolbox.

Draw three short terminals above this busbar ( ). Enlarge the right one.

Connect the three short terminals to the single busbar with three two-winding 

transformers ( ).

Connect a synchronous generator to each of the left two terminals. Use the Flip at 
Busbar utility (in the right mouse menu) if they are drawn downwards.

Connect an asynchronous motor ( )  and a load to the right terminal (plant supply). 
Hold down the Ctrl key while connecting the elements in order to place them 
upwards.

These defined elements form our new power plant model.

This concludes the topological changes. Now please do the following:

Hide the background by clicking on the 'Show Layer' icon ( ).

Freeze the diagram by clicking on the 'Freeze Mode' icon ( ) .
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H.2 Editing the Power Plant

Multi-edit the two new lines (make sure that the editor browser is in the Detailed 
Mode, see F.2 (Editing the Elements) to have: 

- Name = "L_pp1a'' and "L_pp1b'' 

- Type = Project Type -->OHL 110kV 

- Length = 2 km 

Edit the single busbar: 

- Name = "PP110_1'' 

- Type = Project Type --> Bar 110kV 

- Nom. Voltage = 110 kV 

- Substation:
Name = Station Power Plant 1
Short Name = PP1

Edit the three terminals: 

- Name = "Trm_G1'' (left generator ) 

- Name = "Trm_G2'' (right generator) 

- Name = "Trm_EB'' (plant supply) 

- Type = Project Type -->Bar 33kV 

- Nom. Voltage = 33 kV 

Individually edit the two generator transformers: 

- Name = "Tpp1_G1'' (left) 

- Name = "Tpp1_G2'' (right) 

- Type = Project Type -->TR2 60:110/33

If the 'Inconsistent data' error dialog pops up after you press OK on the edit dialog of the 
transformer, you have to flip the connections (high voltage side is connected to the 33 kV 
terminal, while the low voltage side is connected to the 110 kV busbar). One way to do 
that is:

-  Cancel the transformer edit dialog.

- Change to 'No freeze' mode.

- Right click the transformer and then select Disconnect Element.
- Right click again and select Rotate ->180°.
- Right click and select Connect Element.
- Left click on the 110 kV busbar and then on the generator terminal. 

Edit the transformers for the plant supply 

- Name = "Tpp1_EB'' 

- Type = Project Type -->TR2 2;110/33. Flip the connections if required. 
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Multi-edit the two generators (make sure that the editor browser is in the Detailed 
Mode, see F.2 (Editing the Elements): 

- 'Basic Data' page:
Name = "PP1_G1'' (left generator) 
Name = "PP1_G2'' (right generator) 
Type = Project Type --> SGEN 150M/33kV 

- 'Load Flow' page:
Reference Machine = Disabled 
Voltage Control = Power Factor (in the editor browser 'Ctrl Mode' = 0) 
Input Mode = PC (P, cos(phi))
Active Power = 50 MW 
Power Factor = 0.95 

Edit the asynchronous machine: 

- 'Basic Data' page:
Name = "PP1_ASM1'' 
Type = Project Type -->ASM 33kV 3MVA 
Generator / Motor = Motor

- 'Load Flow' page:
Active Power = 2 MW

Edit the load: 

- 'Basic Data' page:
Name = "PP1_L1'' 
Type = Project Type -->General Load Type -->General Load 

- 'Load Flow' page:
Active Power = 0.5 MW 
Power Factor = 0.80 Mvar

Perform a load flow calculation to check the results ( ). 

The two new generators are set to 50 MW each and do not participate in the secondary 
control. This will now be changed: 

Multi select the generators, right click them and select Add To --> Power-Frequency 
Controller.... Select the Power-Frequency Control that is shown in the browser. The 
secondary control adds the generators to its list. 

Select Individual Active Power from the Control Mode field (In the 'Load Flow' tab of 
the Power-Frequency Control). Edit the Active Power Percentages in the list for the 
existing generators to have 33% and the added generators ("SM_2'' and "SM_4'') to 
have 17%. 

Perform a load flow calculation to check the results.

Any differences with the previous load flow calculation? 
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H.3 Performing a Motor Start Simulation

You now have a system with four generators and a big asynchronous motor, which is to 
be analyzed for its motor startup capability. 

To perform a motor start simulation: 

Right click the asynchronous motor "PP1_ASM1'' and select Calculate --> Motor 
Startup 

Set a simulation time of 5 seconds. 

The Motor Start Simulation is a predefined motor startup calculation batch job that 
performs the following tasks:

• Disconnects the asynchronous machine.

• Calculates a new load flow.

• Calculates the initial conditions for all dynamic elements.

• Creates a new graphic board with several predefined output curves.

• Starts a transient simulation and executes a 'Switch Event' to switch on the machine 
during simulation.

• Runs the simulation for 5 seconds. During the simulation, the result plots are updated 
continuously.

The motor start batch job produces four graphs for the motor itself (showing active 
power, current, etc.) and one graph with the voltages of the motor busbar / terminal. One 
of the resulting plots is displayed in the figure H.1. It shows the reactive power demand 
of the asynchronous machine during start up. If the texts are too small to read, point at 
them and a balloon help will pop up, or use the zoom buttons.

 
Fig. H.1: Reactive power demand during startup

From the plots it is seen that after about 3.2 seconds, the motor reaches its nominal 
speed. The steady state demand is about 2.16 MW and 0.99 MVar, which is also shown 
in the single line diagram. This is somewhat surprising, because we did not define a 
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mechanical load for the machine. The 2.16 MW cannot be accounted for as losses, at least 
not for a very long time. So, where's the power used for?

The answer is found in the motor dialogue. 

Double click the asynchronous motor to open its dialogue. 

At the 'RMS simulation' page, it shows parameters for a default mechanical load: 
Proportional factor = 1.0 p.u. (=mdmlp) 
Exponent = 2.0 (=mdmex) 

These two parameters belong to the model of the motor driven machine. This built-in 
model is fairly simple and determined by the following equation, which gives the relation-
ship between torque (xmdm) and speed. 

With the exponent being 2, the power demand is a cubic function of speed.

Of course, this may not be the motor driven machine model that we want. We will replace 
it in the next chapter.

H.4  Changing the MDM

In this section we are going to change the actual motor driven machine model and with 
that introduce other important PowerFactory object called Composite Models. 

Right click the asynchronous machine and select the option Define --> New Motor 
Driven Machine (mdm).

Note Motor driven machine models (mdm) are Power Factory ob-
jects of the element class (ElmMdm...) that enclose information 
about the mechanical load of a motor. The interaction between a 
mdm and a motor is carried out by means of another Power Fac-
tory element object, called Composite Model (ElmComp). 

An 'Element selection' dialogue, which is used to create new objects will pop up. At this 
moment, it only shows a list of three predefined machine driven models and one general 
dynamic model ('Common Model'). 

Select the Mdm__3 (ElmMdm__3) model. 

Press OK 

This creates a new ElmMdm__3 object. The dialogue of the mdm will pop up automat-
ically. 

Make sure that the name of the mdm in the 'Basic Data' page is:

-  Mdm__3.

Edit the values on the 'RMS-Simulation' page: 

- alf1 = 0.95 p.u. 

xmdm mdml speed mdmex⋅=
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- slipm = 0.7 p.u. 

- exp1 = 2.0 

- alf2 = 0.35 p.u. 

- exp2 = 3.0 

- xkmm = 0.15 p.u. 

The machine-mechanical load system is modelled by means of a so called Composite 
Model. The composite model uses a Composite Frame, which is a Power Factory block 
diagram that hard-wires controllers and other models. The default Composite Frame for 
an asynchronous machine is depicted in the figure H.2. Although this Frame has four slots 
(blocks), only the slots for the asynchronous machine ('asm slot') and for the motor driven 
machine ('mdm slot') are used in this exercise.

Note A Composite Model is an advantageous Power Factory object 
used to connect element’s models within a dynamic system. Com-
posite models use a system block diagram representation, called 
Composite Frame. When editing a composite model, the user must 
define a model name, a composite frame and according to the se-
lected frame (model) the blocks (slots) that constitute it. 

After pressing OK in the mdm dialog, the composite model dialog will pop up.

Edit the composite model 'Basic Data' page:

- Name = ''Plant_PP1_ASM1''

- Frame= Select --> ...\Tutorial\Library\Library\Composite Frames\ Composite

                                       Frame ASM

- In the 'Slot Definition' table the 'asm slot' and the 'mdm Slot' fields must be filled 
with the asynchronous machine and the mdm names. The other two fields must 
remain empty. If the slot of the asynchronous machine apears empty after 
changing the Frame definition, please do the following:

Double click in the 'asm' empty slot.
In the browser, select from the left part of the window the grid defined 
as 'Part 2'.
On the right side of the window the asynchronous machine 'PP1_ASM1' 
should now appear. Select the asynchronous machine and press OK.

Fig. H.2: Composite Frame for asynchronous machine
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At this point, you do not have to worry about composite models, because adding a mdm 
to an asynchronous motor is a standard action.

To see the implications of the new mdm, 

Repeat the motor start analysis. 

Now It takes almost 1.4 seconds more for the machine to reach the nominal speed.

This concludes this exercise of the tutorial.
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Chapter I 
Exercise 7: Transient Analysis

In exercise 6, we got a first glimpse of the transient analysis capabilities of the Power-
Factory software. The analysis, however, was more or less performed by the software 
itself. In this seventh exercise of the tutorial, the more direct use of the transient analysis 
features is shown.

Let the Tutorial Manager prepare the Tutorial exercise for you again: 

Activate the Tutorial Manager. 

Select the option Start -> Exercise 7. 

Press Execute. 

I.1 Composite Models Revisited

The active System Stage folder contains four generators, which are still lacking any 
further models, such as prime mover models, primary controllers, voltage controllers, etc. 
A realistic transient analysis is of course not possible with such uncontrolled generators. 
In this exercise, you will add controllers to the two generators in the power plant and 
analyze the system for a short circuit and the subsequent separation of a transmission 
line.

In order to model the controlled generators, composite models for the synchronous 
machines and their controllers must be defined. The project composite frame for a syn-
chronous machine is depicted in the figure I.1. Although this Frame has several slots, we 
will only use the slot for the synchronous machine ('sym slot') and the ones for the voltage 
controller ('vco slot') and the governor or primary control unit ('pcu'). The primary control 
unit (pcu) is a model, which contains the primary controller and the prime mover unit.
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Fig. I.1: Composite Frame for synchronous machine 

We start by giving generator "PP1_G1'' a vco and a primary control unit: 

Open and freeze the single line diagram for the transmission system ("Part 2''). 

Right click generator "PP1_G1'' and select Define --> Voltage Controller (vco).

Select the 'Common Model (ElmDsl)' from the element’s list. A data browser window 
with the message 'Block Definition' pops up. There you have to define the type of the 
new controller. 

In the data browser select the 'vco_IEEET1' from the global library as the type. It can 
be found under the path:

- Database \Library \Models \IEEE \ Models

Edit the voltage controller according to:

- 'Name'= ''VCO_PP1_G1'' 

- 'Parameters':
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Press OK.

The edit dialog for the new synchronous machine composite model pops up. 

Edit the 'Basic Data' page according to the following information:

- Name = ''Plant_PP1_G1''

- Frame= Select -->Database \Library \Models \IEEE \ Frames\IEEE-Frame no-
droop

In the 'Slot Definition' table check that "PP1_G1'' and ''VCO_PP1_G1'' have been 
added to the 'sym slot' and 'vco Slot' respectively. 

If the slot of the synchronous machine appears empty after changing the Frame 
definition, please do the following:

Double click in the 'sym' empty slot.
In the browser, select from the left part of the window the grid defined 
as 'Part 2'.
On the right side of the window the synchronous machine 'PP1_G1' 
should now appear. Select the synchronous machine and press OK.

Press OK.

Right click the generator "PP1_G1'' again and select Define --> Primary Controller 
(pcu). 

Use the controller 'pcuHYGOV' as the type. It can be found in the global library under 
Database \Library \Models \IEEE \ Models. Edit the controller according to:

- 'Name' = ''pcu_PP1_G1''

- 'Parameters': 
Tw = 0,1 s (the rest of the parameters remain with the default value).

- Press OK.

Check that ''pcu_PP1_G1'' has been added to the 'pcu slot' in the 'Slot Definition' table 
of ''Plant_PP1_G1'' and press OK.

Following the same procedure, define controllers for "PP1_G2'':

Right click generator "PP1_G2'' and select Define -->Voltage Controller (vco). 

 Parameters VCO_PP1_G1

Tr   = 0.02 s E1       = 4 p.u.

Ka  = 100 p.u. Se1     = 1.5 p.u.

Ta   = 0.05 s E2       = 6 p.u.

Ke   = 1 p.u. Se2     = 2.5 p.u.

Te   = 0.2 s Vrmin = -8 p.u.

Kf   = 0.0025 p.u. Vrmax= 8 p.u.

Tf   = 1 s
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Select the 'Common Model (ElmDsl)' from the element’s list. 

Use the same 'vco_IEEET1' as the type.

Edit the voltage controller according to:

- 'Name' = ''VCO_PP1_G2'' 

- 'Parameters':

Press OK.

The edit dialog for the new synchronous machine composite model pops up. 

Edit the 'Basic Data' page according to the following information:

- Name = ''Plant_PP1_G2''

- Frame= Select -->Database \Library \Models \IEEE \ Frames\IEEE-Frame no-
droop

In the 'Slot Definition' table check that "PP1_G2'' and ''VCO_PP1_G2'' have been 
added to the 'sym slot' and 'vco Slot' respectively. 

If the slot of the synchronous machine appears empty after changing the Frame 
definition, please do the following:

Double click in the 'sym' empty slot.
In the browser, select from the left part of the window the grid defined 
as 'Part 2'.
On the right side of the window the synchronous machine 'PP1_G2' 
should now appear. Select the synchronous machine and press OK.

Press OK.

Right click the generator "PP1_G2'' again and select Define --> Primary Controller 
(pcu). 

Select the same controller definition 'pcuHYGOV' and the same parameters of 
generator G1. Name it: ''pcu_PP1_G2'' 

Make sure that ''pcu_PP1_G2'' has been added to the 'pcu slot' in the 'Slot Definition' 
table of ''Plant_PP1_G2'', then press OK.

This last step has finished the power plant model definition. Now the transient analysis is 
to be performed.

 Parameters VCO_PP1_G2 

Tr   = 0.01 s E1    = 4 p.u.

Ka   = 150 p.u. Se1  = 1.5 p.u.

Ta   = 0.025 s E2    = 6 p.u.

Ke   = 1.5 p.u. Se    = 2.5 p.u.

Te   = 0.3 s Vrmin  = -7 p.u.

Kf   = 0.001 p.u. Vrmax = 7 p.u.

Tf   = 0.1 s
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I.2 Setting Up a Transient Short-Circuit Simulation

We are now going to test the behaviour of the controlled generators by simulating a single 
phase short circuit at one of the lines which connect the power plant with the transmission 
system. The single phase line fault results in the opening and reclosing of the faulted 
phase and, because that does not clear the fault, the complete separation of the line 
thereafter.

In order to define a short circuit at the line "L_pp1a'', and the resulting switching 
sequence, we have to define the short-circuit and the switching events that will ultimately 
isolate the line.

Events, as any other element within Power Factory, are objects of different classes 
(depending on the event) that can be accessed and edited through the Database 
Manager. The most easy way for defining events for a simulation is to set up the initial 
conditions and then create events by right clicking objects. 

Please note that no protection devices are used in this example.

I.2.1 Setting Initial Conditions

Previous to the transient analysis, the internal variables and the internal operation status 
of connected machines, controllers and other transient models that affect the time-
domain simulation, must be computed based on a load flow calculation.

The 'Calculate Initial Conditions' command ( ) allows the determination of the transient 
simulation settings and calculates the initial conditions (initialize the simulation). We will 
run an unbalanced stability simulation using RMS values, which is normally used to 
analyze the behaviour of the control systems.

To set initial conditions:

Activate the "Stability'' toolbar by clicking on the  icon on the main toolbar 
(normally this toolbar is activated by standard). 

Click on the  icon to open the initial calculation command. 

Set the following options: 

- Method of simulation = RMS Values (Electromechanical Transients) 

- Unbalanced, 3-Phase (ABC)

- Verify initial conditions = enabled 

- Automatic step size Adaptation = enabled 

Press Execute to calculate a load flow and then the initial conditions.

After the command execution, the final message 'Initial Conditions 
Calculated' should appear on the output window. 

Correct possible mistakes. 
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I.2.2 Defining Events

With the simulation initiated, you may now start defining the events:

Short Circuit Event: 

Right click the line "L_pp1a'' and select Define -->Short-Circuit Event. This will create 
a new event (short circuit event EvtShc) and open the event dialog. 

Edit the new event:

- Execution Time = 0.0 s 

- Fault Type = Single Phase to Ground Fault

- Phase = a 

- Fault resistance = 0.0 Ohm 

- Fault Reactance = 0.0 Ohm 

Press the Edit button at the Object field ( ). The line dialogue appears. 

At the ' RMS-simulation' page, enable the option Short-Circuit at Line - Available 

Set the short-circuit location to 50%.

Close the line dialogue by pressing OK.

Close the event dialogue by pressing OK. 

Events are saved in the active study case under the 'Simulation Events' folder ( ); from 
there they can be accessed and edited. 

The Short-Circuit at Line option at the line object must be set to prepare the calculation 
for a line with a short circuit event. This inserts an extra calculation busbar at the fault 

location in the line. This requires that you re-initiate the simulation by clicking on the  
icon.

Switching Events:

After clicking again on the  icon and then pressing  Execute you are ready to create 
the switching events: 

Right-click the top switch at line "L_pp1a'' and select Open, or double-click it. This will 
create and show a new switch event (EvtSwitch). 

Set the following data in the 'Basic Data' page: 

- Execution Time = 0.2 s 

- Action = Open 

- All Phases = disabled

- Phase b and c = disabled 

- Phase a = enabled 

Repeat the same procedure for the bottom switch. Make sure that the correct switch 
is selected ! If the switch was not right clicked, but the line, an event for the top 
switch will automatically pop up. 
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Right click the top switch again, and select Open.

Set the following data in the 'Basic Data' page:

- Execution Time = 0.3 s

- Action = Close

- All Phases = disabled

- Phase b and c = disabled

- Phase a = enabled

Repeat for the switch on the other side.

For a third time, right click the top switch, select Open and set: 

- Execution Time = 0.4 s

- Action = Open

- All Phases = enabled

Repeat for the other switch

To check the list of the defined events do the following:

Click on the  icon to open the event list.

Check the events and correct mistakes.

If not detailed information of the events can be seen in the browser, press the 'Detailed 

Mode' button ( ). Remember that only elements of the same class can be seen in the 
detailed mode.

I.3 Defining Results Objects and Variables Sets

I.3.1 Defining Variable Sets

In order to produce graphs from the transient simulation, we have to define which 
variables are to be stored by the simulation. The PowerFactory software has thousands 
of possible variables which could all be stored and analyzed. However, storing them all 
would take too much time, would produce megabytes of data and would make it very 
difficult to select a variable for displaying its values in a graph.

The solution is to select a number of variables prior to the simulation. This is done by 
creating so-called 'Variable Sets' for each power system element that we are interested 
in. The Tutorial Manager has already defined some of these sets (for the generator 
''PP1_G1'', for the terminals ''Trm_G1'' and ''Trm_G2'' and for the line ''L_pp1a''); you are 
going to define the one for generator "PP1_G2''.

In the Tutorial project, the 'Variable Sets' are stored in the study case (''Case1'') under 
the folder ''Results''. As you will notice Variable Sets are Power Factory objects of the 
class 'IntMon'.
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To create the "PP1_G2'' variable set:

Freeze the single line diagram. 

Right click generator "PP1_G2'' and select Define -->Variable Set (Sim). This will lead 
you to the ''Results'' folder, where the already created variable sets are stored. 

Notice that whenever you define a variable set for an element within the power system 
(as in the previous step), a new, empty variable set for that element is created in the 
''Results'' folder.

Double click the icon of the ''PP1_G2'' variable set in the ''Results'' folder to edit it. A 
''Variable Set'' object dialog, as the one depicted in figure I.2, will pop up. 

Select the RMS-simulation page.

In the ''Filter for'' field select ''Currents, Voltages and Powers'' from the "Variable Set'' 
menu. 

Select "bus1:A'' from the "Bus Name'' menu.  

Select the variable: 
I:bus1:A kA Phase Current, Magnitude

Press the  button to move the selected variable(s) to the right panel. 

 Select "Bus Name'' = "bus1:B'' 

Select the variable: 
I:bus1:B kA Phase Current, Magnitude

Press the  button to move the selected variable to the right panel. 

 Select "Bus Name'' = "bus1:C'' 

Select the variable: 
I:bus1:C kA Phase Current, Magnitude 

Press the  button to move the selected variable to the right panel. 

Select "Variable Set'' = "Signals'' 

Multi-select the variables 
psie - p.u. Exitation-Flux 
speed - p.u. Speed 
ve - p.u. Excitation Voltage
phi - p.u. Rotor-angle 
pt - p.u. Turbine Power 
xspeed - p.u. Speed 
P1 - MW Active Power
Q1 - MW Reactive Power

Press the  button to move the selected variables to the right panel. 

Select "Variable Set'' = "Calculation Parameter'' 

Select and move to the right panel the variable
c:dfrotx - deg Maximum Rotor Angle difference 

Close the variable set by pressing the Ok button.
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Fig. I.2: Defining a variable set 

I.4 Running Transient Simulations and Creating Plots

During a simulation, all variables defined in the variables sets are written to a result file 
(I.3). That result file is used to define graphs and other kinds of virtual instruments (VI's). 
A virtual instrument is a tool for displaying calculated results. The most common use of a 
VI is to look at the results of a time-domain simulation, like an EMT or RMS simulation, 
by defining one or more plotted curves. These curves show the variables changing with 
time. 

In this part of the Tutorial we are going to introduce some of the features of virtual instru-
ments to visualize the results of the transient analysis. Further information on this 
powerful tool can be found in the User’s Manual.

Before performing a transient simulation and generating graphics of the calculated 
results, it is important to distinguish the concepts of virtual instruments, virtual instrument 
panel and plots:   

• The Virtual Instrument Panel is a page in the active graphics board, where 
different plots or graphs (virtual instruments) are stored and displayed. Also the basic 
information about the included virtual instruments is stored here.

• The Virtual Instruments display the results of one or more variables or parameters 
in various ways (Plots, Bar Diagrams, Vector Diagrams, etc.). Every VI can be set up 
individually to the need of the variable(s) which is to be displayed. The virtual 
instruments are shown on the VI panel.
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• Plots are one of the many different ways in which a VI display the information about 
the variables it has. Plots show all sorts of time-domain variables depending on other 
variables. Plots can be used in different ways (subplots, subplots with two y axis, X-Y 
plots and FFT plots). In this part of the Tutorial plots are used as subplots.

I.4.1 Running a Transient Simulation

The main toolbar shows two icons for starting ( ) and stopping ( ) the transient sim-
ulation. 

Click on the start ( ) icon. Enter an execution time of 10s. 

Press Execute 

The simulation is now started. The output window will show messages about the events 
that are processed, when they are processed. The predefined graphs (in the ''Generators'' 
Virtual Instrument Panel) will start to show results.

All plots can be scaled automatically in the x- respectively y-direction to the best view by 

clicking on the icons  and . Furthermore for a better analysis of certain time period 
or a closer look at the graphs, the x- and y-axis can easily be zoomed in using the 'Zoom 

x-Axis' icon ( ) and the 'Zoom y-Axis' icon ( ). 

I.4.2 Defining New Virtual Instruments

The Tutorial Manager has already defined the Virtual Instrument Panel called ''Genera-
tors''. It contains two plots, displaying the speed and the turbine power of the generator 
PP1_G1. Now you are going to create the same plots for the generator PP1_G2:

Open (if not already open) the Virtual Instrument Panel ''Generators'' and click on the 

the "Append new VI's'' ( ) icon. 

In the dialog that pops up, select the "Subplot (Visplot)'' object. 

Set the desired number of new subplots (in this case 2).

 Click on the  icon to arrange the plots by pairs (if you prefer a vertical 

arrangement use the  icon). 

  Double click on the first empty (or bottom-left) subplot to open its edit dialog and 
define the variables to display.

In the ''Curves'' field (bottom of the edit dialog), double click on the empty Element 
field to select an element. A data browser, showing the elements with defined variable 
sets, pops up (figure I.3). Double click on the PP1_G2 icon to select it. 
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Fig. I.3: Selecting an element to display the calculated results in a plot 

In the subplot dialog, double click on the empty ''Variable'' field to select the variable 
to display. From the displayed variables list (which corresponds the list defined in the 
variables set I.3.1), select ''s:speed'' (figure I.4).

 
Fig. I.4: Selecting a variable to display in a subplot 

 If you want to change the plot colour, double click on the ''Colour'' field. You can also 
edit the line style and line width.

Press the Ok button on the edit dialog, to visualize the newly defined subplot. If 

required, use the  icon to get a better view.

Following the same procedure, display the turbine power (''s:pt'') of PP1_G2 in the 
remaining empty subplot. 

Run a transient simulation with an execution time of 70 s. Adjust the view of your 

plots with  and . Steady state was reached? Increase your simulation time.
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I.4.3 Selecting Variables to Show in a Plot

You can change and add new variables to a plot. To illustrate this functionality, you are 
going to display the active and the reactive power of generator ''PP1_G2'', in the bottom-
right (or last) plot of the virtual instrument panel:

Double click on the subplot of the virtual instrument panel that displays the turbine 
power of ''PP1_G2''.

Double click on the ''Variable'' field of the defined curve and select ''s:P1' from the 
displayed variables list.

Rigth click on the curve number and select ''Append Rows''  from the context sensitive 
menu (Figure I.5). A new row in the ''Curves'' field is generated, there you can define 
a second variable to display in your subplot.

 
Fig. I.5: Adding a new variable to a subplot 

Following the instructions given in section I.4.2 define the new curve to display the 
reactive power of generator ''PP1_G2'' (''s:Q1''). Your subplot should look now like 
Figure I.6 (for the first 10 seconds).

  
Fig. I.6: Virtual Instrument subplot displaying two variables 

Modify the existing plots to show the following variables, which are important for 
analyzing the behaviour of a power plant during a short-circuit. 
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Speed ’speed’ of generator G1 and G2.

Active and reactive power ’P1’ and ’Q1’ of generator G1 and G2.

Rotor angle ’phi’ of generator G1 and G2.

Turbine power ’pt’ of generator G1 and G2.

Excitation voltage ’ve’ of generator G1 and G2.

Phase currents of generators and on lines.

The steps to create plots are described in the next chapters.

I.4.4 Creating a New Empty VI Page

In this section you are going to create a new virtual instrument panel to display the short 
circuit currents and voltages at the generators terminals and at the line ''L_pp1a''. The 
Tutorial Manager already defined variable sets for these elements. To create a new virtual 
instruments page (panel): 

Press the "Insert New Graphic'' button ( ) on the Graphics Board toolbar and select 
Virtual Instrument Panel.

In the new empty page create 4 subplots following the procedure indicated in I.4.2 

( ). 

In the first subplot display the phase currents of generator ''PP1_G1'' (''m:I:bus1:A'', 
''m:I:bus1:B'', ''m:I:bus1:C'').

In the second subplot display the voltages in kV at the terminal ''Trm_G1'' (''m:U:A'', 
''m:U:B'', ''m:U:C'').

In the third subplot display the per unit phase voltages at ''Trm_G1'' (''m:u:A'', 
''m:u:B'', ''m:u:C'').

In the last subplot display the per unit short circuit currents at line ''L_pp1a'' 
(''m:i:bussch:A'', ''m:i:bussch:B'', ''m:i:bussch:C'').

Use the scale and zoom functions in order to adjust the view of the defined plots.  

I.5 Closing Up the Tutorial

In this exercise of the tutorial the following was explained: 

How to define Composite Models for elements

How to perform a transient analysis 

How to define new result variables 

How to change, create and modify Subplots 

As with the other tutorial exercises, now it is possible to add a prepared project to the 
user defined finished seventh Tutorial Exercise project. As this concludes the tutorial, 
there's no need for correction of the project for further tutorial exercises, however, it 
could be of help when some difficulty was encountered during the construction of the 
seventh tutorial exercise by the user, or if experiments led to an unclear situation, the 
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Tutorial Manager could build the complete seventh exercise in its final state for you.

To install the prepared seventh tutorial in its final state, please do the following: 

Select the option File --> Setup Tutorial on the main menu to open the Tutorial 
Manager. 

Select the option Show Sample Solution (includes all exercises).

Press the OK button.

The topics covered through this Tutorial are sufficient to give a brief introduction to the 
basic features and terminology of the Power Factory environment. New users are 
invited to reinforce the acquired knowledge and to learn new specific features by going 
through the examples provided in this Help Package. The User’s Manual and the Technical 
References always provide the necessary information to make use of the outstanding 
Power Factory features.
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